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History of Changes

History of Changes

Date Changes Reason
2011-12-16 | First draft

2012-01-27 | More information about anti-virus software (see Section 2.6.2.1, “Server”, on page 57) CQ00193820

2012-01-27 | A voice conference scheduled with n participants requires n+2 licenses (see Section 2.4.6,
“Extension Restrictions on Conferences and OpenScape WebClient”, on page 53).

2012-01-27 | The telephone user interfaces (TUI) ERGO, PhoneMail and VMS are supported (see
Section 5.5.1, “ERGO, PhoneMail and VMS”, on page 101).

2012-01-27 | Connecting OpenScape UC Application V6 RO is supported (see Section 2.2, “New
Features”, on page 23).

2012-01-27 | Upgrading MRS 8.xx to XPR 7 RO is supported (see Section 2.2, “New Features”, on page | RQ00033308
23 and Section 5.2, “Upgrading”, on page 96).

2012-02-10 | The following features are not supported anymore:

- MMCC (Multimedia Contact Center)

- x-Kit

- TNG (The Next Generation)

- SAPbyDesign

See Section 2.2, “New Features”, on page 23 and point 38 on page 75.

2012-02-10 | Configuration parameters of a virtual computer for the XPR server updated (see footer 2
of Table 13 on page 51 and footer 2 of Table 14 on page 52)

2012-02-10 | The Internet Explorer 6.5 is not longer supported (see Section 2.6.2.2, “Clients”, on page | CQ00197505
66).
SSL2 and SSL3 have been replaced with TLS (see point 40 on page 76).

2012-02-13 | Connecting the XPR server to the following software is supported (see Section 6.1.8,
“Connection to Exchange Server 2010”, on page 110):

- Exchange Server 2010 DAG

- Exchange Server 2010 DAG and CAS

- Exchange Server 2010 CAS Array

- Exchange Server 2010 DAG and CAS Array

2012-03-09 | TTS and ASR have been released only for specific operating systems and only on real CQ00192557
hardware or on VMware ESX 4.0 (see footer #in Table 17 on page 57 and point 41 on page

76).

2012-03-09 | CTl is not supported for HiCom 300E US, HiPath DX V7.0 and ROLM 9752 (see footer T 1cQ00199296
on page 18).

2012-03-09 | Column Voice conference added to Table 1 on page 21. CQ00199296

2012-03-09 | Hardware specifications updated (see Section 2.4.1, “Server”, on page 35): CQ00199296
- RAM size
- LAN box

2012-03-09 | More information about the hard disk priority of a virtual computer (see point 2d on page | CQ00199296
63)

2012-03-09 | No mailbox replication for Exchange Server 2010 (see point 1 on page 82) CQ00199296

2012-03-09 | Sections “Generating a License File” and “General Information on Administration” CQ00199296
removed.
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History of Changes

Date Changes Reason

2012-03-09 | Information about a Microsoft Exchange server 2003 as gateway between the XPR and an
Exchange server 2007 or 2010 removed. It is no longer required (see Section 3.4,
“Exchange Integration Restrictions”, on page 82).

2012-07-09 | If conferences are supported, an upgrade can only be directly performed to XPR 7 RO from
XPR 6 R2 or MRS 8.03 (see footer S in Section 5.2, “Upgrading”, on page 96).

2012-07-09 | The antivirus program AV4UC (Trend Micro) has been released (see Antivirus programs
on page 64).

2012-07-09 | OpenScape Voice V7 RO has been released (see for example Table 1 on page 21).

2012-07-09 | VMware ESXi V5 has been released (see for example in Section 2.4.2, “OpenScape FRN5078
Xpressions optiClient Extensions”, on page 40, footer 4in Table 17 on page 57, VMWare
on page 59 and point 41 on page 76)

2012-07-09 | Microsoft Office 2010 can be used for the application conversion in the 64-bit version also
(see Section 2.6.2.2, “Clients”, on page 66).

2012-07-18 | A PrintAPL supports a maximum of 150 printers (see point 42 on page 76).

2012-08-17 | Information about operating systems for Exchange 2003 Connector added (see point 6 on
page 82)

2012-09-18 | Maximum number of channels for CorNet IP (G.711) on VMware ESXi added (see Table
13 on page 51 and Table 14 on page 52)

2012-09-18 | Internet Explorer 9 and Firefox 3.6 released (see Section 2.6.2.2, “Clients”, on page 66) |FRN4913

2012-09-18 | The WebAssistant can be configured to prevent playing voicemails on the PC (see Section | FRN5516
2.2.6, “New Features with V7 R1”, on page 28).

2012-09-18 | The configuration of the Trusted Transfer Mode has been revised (see Section 2.2.6, “New | FRN4930
Features with V7 R1”, on page 28).

2012-09-18 | New parameter tenant for the Vogue protocol. This protocol can thus also be used ina | FRN5258
multi-tenant environment (see Section 2.2.6, “New Features with V7 R1”, on page 28).

2012-09-18 | Using the FI APL configuration script XprConfig.e the location and tenant settings can | FRN5259
be imported in the XPR server via a configuration file (see Section 2.2.6, “New Features
with V7 R1”, on page 28).

2012-09-18 | The WebClient journal also displays entries of unavailable phones, for example of a FRN4907
softphone on a shut-down computer (see Section 2.2.6, “New Features with V7 R1”, on
page 28).

2012-09-18 | The name dialing control of the Application Builder has been extended by a filter (see FRN5515
Section 2.2.6, “New Features with V7 R1”, on page 28).

2012-09-18 | The Fax G3 protocol parameters UseFaxldAsOAD, InsertMidHI and CheckPageNumbers | FRN4914
are supported by the IP APL also (see Section 2.2.6, “New Features with V7 R1”, on page

28).
2012-09-18 | Information about operating systems for Exchange 2003 Connector updated (see point 6

on page 82)
2012-09-18 | IPv6 is not supported by XPR (see point 43 on page 76). CQ00215681
2012-09-18 | Upgrade table updated (see Section 5.2, “Upgrading”, on page 96) FRN5334,

CQ00219597

2012-10-31 | VMware ESXi V5.1 is supported with restrictions (see Section 2.6.2.1, “Server”, on page
57).

2012-10-31 | The PBX HiPath 3000 V9 has been released (see Section 2.1, “PBX Connection Options”, | FRN5711
on page 17 and Table 1 on page 21).
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Date Changes Reason

2012-10-31 | The following browsers are supported for the WebAssistant: Internet Explorer 7.0, 8.0 and | FRN5512
9, Firefox 16.0.1, Safari 5.1.7 and Chrome 22.0 (see Section 2.2.6, “New Features with
V7 R1”, on page 28 and Section 2.6.2.2, “Clients”, on page 66)

2012-10-31 | Lotus Domino 8.5.3 and Lotus Notes 8.5.3 are supported (see Section 2.2.6, “New
Features with V7 R1”, on page 28 and Section 2.6.2.2, “Clients”, on page 66)

2012-11-06 | Connecting the XPR server to an Alcatel OmniPCX Enterprise (OXE) R10 and R10.1 has
been released (see Section 2.1, “PBX Connection Options”, on page 17, Table 1 on page
21 and Section 2.2.7, “New Features with V7 R0”, on page 29).

2012-11-14 | The G.711 fax support for OpenScape Voice V5, V6 and V7 has been set to “Not released
yet” (see Table 1 on page 21).

2012-11-16 | Section 2.5, “Languages”, on page 55 added.

2012-11-16 | VMware vMotion has been released with restrictions (see Section 2.2.6, “New Features | FRN4910
with V7 R1”, on page 28 and Section 2.6.2.1, “Server”, on page 57).

2012-12-10 | French removed for the Application Builder (see Table 15 on page 55)

2012-12-10 | Conference languages added (see Table 16 on page 55) CQ00225490

2012-12-10 | You cannot perform a phone number normalization depending on the invoking user for
MSPTSP applications (see point 45 on page 77).

2012-12-10 | The Cisco Unified Communications Manager 9 is supported (see e. g. Table 1 on page 21). | FRN5711

2012-12-11 | Data backup and restore on virtual computers with Windows Server 2008 R2 is supported | FRN4908
for three different tools (see Section 2.2.6, “New Features with V7 R1”, on page 28 and
point 7 on page 63).

2013-01-08 | Multi-tenants are only supported for SIP connections, PhoneMail and Vogue but not for | CQ00240176
H.323 connections (see Section 2.2.6, “New Features with V7 R1”, on page 28 and point
46 on page 77).

2013-01-08 | VMware ESXi V5.1 is supported without special restrictions (see Section 2.2.6, “New FRN6611
Features with V7 R1”, on page 28, Section 2.6.2.1, “Server”, on page 57 and point 41 on
page 76).

2013-01-08 | VMware High Availability is supported (see point 1 on page 61).

2013-01-21 | The multi-tenant features that apply for SIP connections only are the new features (Vogue
support and support of the location and tenant settings of the XPR server with help of the
FI APL and a configuration file) (see Section 2.2.6, “New Features with V7 R1”, on page
28 and point 46 on page 77).

2013-01-24 | In all passages of this documentation, Lotus Domino 8.5.3 and Lotus Notes 8.5.3 have
been released.

2013-02-18 | Table 13 on page 51, “Maximum number of channels for the single-node scenario”, and
Table 14 on page 52, “Maximum number of channels for the kernel-satellite scenario”,
updated.

2013-02-18 | If you use real computers for the XPR server, a maximum of 20000 users is supported, on
virtual computers a maximum of 15000 (see Chapter 1, “General Considerations”, Section
2.4.1,“Server”, on page 35, Section 2.4.2, “OpenScape Xpressions optiClient Extensions”,
on page 40, and step 4 on page 63).
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Date Changes Reason

2013-05-23 | Operating systems for the XPR server: FRN5992,
UEFI Unified Extensible Firmware Interface) is not supported for the XPR server (see FRN4909
footer ! in Table 17 on page 57).

Windows Server 2012 Standard Edition has been added. Operating system support has
been divided in real and virtual computers (see Table 17 on page 57, “Released operating
systems for the XPR server on real and virtual computers”).

Operating systems for the clients:
UEFI is not supported for the clients (see Section 2.6.2.2, “Clients”, on page 66).
Windows 8 Pro Edition has been added (see Section 2.6.2.2, “Clients”, on page 66).

2013-05-23 | Internet Explorer 10 is supported by the XPR Web Assistant (see Section 2.2.5, “New FRNG6525
Features with V7 R1 FR1”, on page 26 and Section 2.6.2.2, “Clients”, on page 66).

2013-05-23 | Sub-section “VMWare” on page 59 updated and Table 18 on page 60, “Virtual Machine | FRN4909
configuration parameters” added.

2013-05-23 | While VMware vMotion is being used, no CPU core must be permanently assigned to a
virtual computer (see point 2 on page 61).

2013-05-23 | Catalan is supported for specific features (see Section 2.2.5, “New Features with FRN7057
V7 R1 FR1”, on page 26 and Section 2.5, “Languages”, on page 55).

2013-05-23 | Smaller fix release packages are possible (see Section 2.2.5, “New Features with FRN5399
V7 R1 FR1”, on page 26).

2013-05-23 | VMware Data Recovery on VMware ESXi V4.x is supported (see Section 2.2.6, “New
Features with V7 R1”, on page 28 and point 3 on page 61).

2013-05-23 | The fax printer driver has been removed from the list of unsupported client programs for
64-bit operating systems (see Section 2.6.2.2, “Clients”, on page 66).

2013-05-23 | “Support of the Outlook Extensions for Microsoft Outlook 2010 64-bit in the 32-bit mode”
has been replaced with “Support of the Outlook Extensions for the 32-bit version of
Outlook 2010 on 64-bit operating systems” (see Section 2.2.7, “New Features with V7 R0”,
on page 29).

2013-05-23 | CSV import with the Web Client is not supported for Outlook 2010 (see point 23 on page | CQ00251063
73).

2013-06-12 | The silent upgrade is supported for certain versions under certain circumstances (see FRN6055
Section 2.2.5, “New Features with V7 R1 FR1”, on page 26 and point 47 on page 77).

2013-06-26 | Up to 60 T.38 fax channels are supported per STMI for HiPath 4000 V6 R2.14.1
(HF003111) and higher independent of the STMI version (see Section 2.4.4.4, “HiPath
4000 with HG35xx”, on page 47).

2013-07-31 | Changes in Table 17 on page 57, “Released operating systems for the XPR server on real
and virtual computers”:

The support of Windows Server 2008 R2 has been changed to Windows Server 2008 R2
SP1. This applies to Windows clusters as well.

Windows Server 2008 R2 SP1 Datacenter Edition is supported. This applies to Windows
clusters as well. However, Windows Server 2008 Datacenter Edition is not supported.

2013-10-07 | Internet Explorer 10 is supported by XPR WebClient (see Section 2.2.4, “New Features | FRN7049
with V7 R1 FR2”, on page 26 and Section 2.6.2.2, “Clients”, on page 66).

2013-10-07 | Restriction for Internet Explorer 10 added (see Section 2.6.2.2, “Clients”, on page 66) CQ00270474

2013-10-07 | The configuration for a sample configuration has been changed (see footnote "in Table 11
on page 48, footnote "in Table 12 on page 49, footnote "in Table 13 on page 51 and
footnote " in Table 14 on page 52). Use the load and dimensioning tool for more detailed
values.
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Date Changes Reason

2013-10-07 | If you want to upgrade an XPR or MRS that is installed on a Windows cluster to XPR 7 R1,
you need a project-specific release under certain conditions (see point 7 on page 80 and
footnote 2 in Section 5.2, “Upgrading”, on page 96).

2013-10-07 | Voice conferences are not supported anymore for HiPath 3000 V5, V6 and V7 and HiPath
4000 V3 and V4 (see footnote in Table 1 on page 21, Section 2.4.6, “Extension
Restrictions on Conferences and OpenScape WebClient”, on page 53 and Section 5.2,
“Upgrading”, on page 96).

2013-10-30 | The name “Unify” has been introduced.

2013-10-30 | Forwarding incoming calls to another phone number if your office phone is engaged or if
the specified ring time of the device is exceeded is not supported for a connection to a
HiPath 4000/OpenScape 4000 via SIP or for a connection to a HiPath 3000 (see point 48
on page 78).

2013-10-30 | XPR on Windows Server 2012 requires .NET Framework 3.5 (see footnote 6in Table 17
on page 57).

2013-11-05 | The .NET Framework version in footnote & in Table 17 on page 57 has been updated.

2013-12-17 |“SEN ESY HA AR TS” removed

2014-02-10 | R2 of Windows Server 2012 is supported by the XPR server (see Section 2.2.3, “New FRN7927
Features with V7 R1 FR3”, on page 25 and Table 17 on page 57).

2014-02-10 | Windows 8.1 Pro Edition is supported for clients (see Section 2.2.3, “New Features with | FRN7854
V7 R1 FR3”, on page 25 and Section 2.6.2.2, “Clients”, on page 66).

2014-02-10 | Microsoft Office 2013 is supported (see Section 2.2.3, “New Features with V7 R1 FR3”, on | FRN6617
page 25 and Section 2.6.2.2, “Clients”, on page 66).

2014-02-10 | VMware ESXi V5.5 is supported (see Section 2.2.3, “New Features with V7 R1 FR3”, on | FRN7740
page 25, footer 4 in Table 17 on page 57, subsection VMWare in Section 2.6.2.1, “Server”,
on page 57 and item 41 on page 76).

2014-02-10 |IBM Notes 9 and IBM Domino 9 are supported (see Section 2.2.3, “New Features with FRN6618,
V7 R1 FR3”, on page 25, Section 2.4.2.1, “Software Requirements”, on page 41, Section | FRN7467
2.6.2.1, “Server”, on page 57, Section 2.6.2.2, “Clients”, on page 66 und Section 3.6,
“Restrictions on the Lotus Notes Integration”, on page 84).

2014-02-19 | The support of IBM Notes 9 and IBM Domino 9 has been changed to the support of IBM
Notes 9.0 Social Edition (Basic Configuration) and IBM Domino 9 Social Edition (see
Section 2.2.3, “New Features with V7 R1 FR3”, on page 25, Section 2.4.2.1, “Software
Requirements”, on page 41, Section 2.6.2.1, “Server”, on page 57, Section 2.6.2.2,
“Clients”, on page 66 und Section 3.6, “Restrictions on the Lotus Notes Integration”, on
page 84).

2014-03-10 | If you connect XPR to IBM Notes 9.0 Social Edition (Basic Configuration) and IBM Domino
9.0 Social Edition, use the mail templates for Lotus Notes 8 (see Section 2.4.2.1, “Software
Requirements”, on page 41, Section 2.6.2.1, “Server”, on page 57, Section 2.6.2.2,
“Clients”, on page 66 and point 7 on page 85).

2014-03-10 | OpenScape 4000 V7 is supported (see for example Section 2.1, “PBX Connection
Options”, on page 17, Table 1 on page 21, Section 2.2.3, “New Features with V7 R1 FR3”,
on page 25).

2014-03-20 |A Windows cluster based on Windows Server 2012 R2 Datacenter Edition is supported by
the XPR server (see Section 2.2.3, “New Features with V7 R1 FR3”, on page 25 and Table
17 on page 57).
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2014-04-07 | The Outlook extensions for the 64-bit version of Outlook 2010 on 64-bit operating systems | FRN5333
are supported (see Section 2.2.3, “New Features with V7 R1 FR3”, on page 25 and
Section 2.6.2.2, “Clients”, on page 66).

2014-05-15 | XPR on VMware ESXi V5.5 is supported only for up to 10000 users. A project-specific | FRN7740
release is needed for more than 10000 users. (see VMWare on page 59, footnote Tin Table
18 on page 60 and point 50 on page 78).

2014-05-15 | Additionally released operating operating systems for the XPR Server (see Section 2.2.3,
“New Features with V7 R1 FR3”, on page 25 and Section 2.6.2.1, “Server”, on page 57):
Without a Windows cluster:

¢ Windows Server 2012 R2 Datacenter Edition

¢ Windows Server 2012 R2 Standard for Embedded Systems - Telecommunications

¢ Windows Server 2008 R2 SP1 for Embedded Systems - Telecommunications

* Windows Server 2003 R2 SP2 Datacenter Edition

With a Windows cluster:

¢ Windows Server 2012 R2 Standard for Embedded Systems - Telecommunications

* Windows Server 2008 R2 SP1 for Embedded Systems - Telecommunications

¢ Windows Server 2003 R2 SP2 Datacenter Edition

2014-05-15 | Windows Server 2008 without R2 is not supported anymore for the XPR Server (see
Section 2.6.2.1, “Server”, on page 57).

2014-05-15 | Upgrade from versions lower than XPR V5 removed (see Section 5.2, “Upgrading”, on
page 96)

2014-05-15 | The Outlook extensions for the 64-bit version of Outlook 2013 on 64-bit operating systems | FRN8228
are supported (see Section 2.2.3, “New Features with V7 R1 FR3”, on page 25 and
Section 2.6.2.2, “Clients”, on page 66).

2014-05-26 | OpenScape Voice V8 is supported (see for example in Table 1 on page 21 and Section
2.2.3, “New Features with V7 R1 FR3”, on page 25).

2014-06-03 | Alcatel OmniPCX Enterprise (OXE) R11.0 is supported (see for example in Table 1 on FRN8318
page 21 and Section 2.2.3, “New Features with V7 R1 FR3”, on page 25).

2014-06-16 | Table 18 on page 60, “Virtual Machine configuration parameters”, has been updated and | CQ00301593
partly moved to the installation guide OpenScape Xpressions Serve Installation.

2014-08-21 | “Freely available” removed for VMware ESXi Server (see Section 2.6.2.1, “Server”, on
page 57).

2014-08-21 | “Dialogic Diva BRI-2 PCI” has been removed (see Section 2.4.1, “Server”, on page 35).

2014-08-21 | OpenScape Business V1 is supported (see Section 2.1, “PBX Connection Options”, on
page 17 and Section 2.2.3, “New Features with V7 R1 FR3”, on page 25).

2014-10-10 |A connection to a Microsoft Exchange Server 2013 via a Microsoft Exchange 2007 FRN7973
gateway is supported.

A project-specific release is required for a connection to a Microsoft Exchange Server
2013 via a Microsoft Exchange 2010 gateway.

(see Section 2.2.3, “New Features with V7 R1 FR3”, on page 25, Section 6.1.2,
“Supported Exchange Versions”, on page 103, Section 6.1.4, “Multi-Connector Operation”,
on page 104 und Section 6.1.9, “Connecting to Exchange Server 2013 via an Exchange
2007/2010 Domain”, on page 111)

2014-11-17 | The sentence “MSPTSP is not supported on 64-bit operating systems.” has been CQ00313979
removed.

2014-11-17 | MAPI fax printer drivers are supported for terminal server environments with Citrix (see
step 17 on page 72).
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Date Changes Reason
2014-11-17 | The 64-bit version of Outlook is not supported by optiClient 130 (see Section 2.6.2.2,
“Clients”, on page 66 and point 22 on page 73).
2014-11-17 | VMware configuration parameters (see Table 18 on page 60):
XPR on VMware ESXi for 15000 users needs a project-specific release. This is possible
for VMware ESXi V5.5 as well (see footnote 1).
A kernel with at least 3 virtual CPUs is needed for 15000 users.
The unit of information for the hard disk throughput has been changed from kb/s to kB/s.
2014-11-17 | The hint that VMware Data Protection is not supported for VMware ESXi V5.5 has been
removed (see Section 2.6.2.1, “Server”, on page 57).
2014-11-17 |Adirect connection to a Microsoft Exchange Server 2013 is supported (see Section 2.2.2, | FRN8302
“New Features with V7 R1 FR4”, on page 24, Section 6.1.2, “Supported Exchange
Versions”, on page 103, and Section 6.1.10, “Connection to Exchange Server 2013”, on
page 113).
2015-02-04 |ADDED: Note on Internet Explorer 11 being supported by Xpressions WebClient only FRN9789
when running in Compatibility View Mode to Section Clients,Paragraph For the WebClient
2015-02-04 | ADDED: Paragraph on Internet Explorer 11 being supported by Xpressions WebClient FRN9789
only when running in Compatibility View Mode to Section New Features with
V7 R1 FR4,Paragraph Newly supported browsers
2015-02-04 |ADDED: Paragraph on Internet Explorer 11 being supported by Xpressions WebClient FRN9789
only when running in Compatibility View Mode and paragraph on pearl icon to Section
Information for Users
2015-02-04 |ADDED: point 50 On Internet Explorer 11 being supported by Xpressions WebClient only | FRN9789
when running in Compatibility View Mode, point 51 on DI-Tool not being supported by IE11
and point 52 on Windows 8 Metro not being supported.
2015-03-20 | REMOVED:Dynamic resource management from Section 2.6.2, “Not included in the CQ00326929
Scope of Delivery” and Section 3.1, “General Restrictions”
2015-04-16 | UPDATED:Step 49 XPR on Virtual Machine is supported only for up to 10000 users. A CQ00330115
project-specific release is needed for more than 10000 users.in Section 3.1
2015-04-16 | UPDATED:History of change entry “2014-05-15", on page 10 for FRN7740 CQ00330115
2015-12-21 |ADDED: “The communications client does not support tenant features. The WebAssistant | UCBE-2077
is recommended to be used to work with tenant users.” To restrictions.
2016-4-4 |UPDATED: Table 17 “Released operating systems for the XPR server on real and virtual | UCBE-5523
computers” for UCBE-5523
2017-02-07 | Updated: Section 2.2 New Features UCBE-9747
- Add Subchapter for New Features with V7 R1 FR5
2017-02-07 | Updated: Section 2.1 PBX Connection Options review
- remove HiPath 4000 V3, V4, V5
- remove OpenScape Voice V3.1, V4, V5, V6
- add OpenScape Voice V9
Adapt Table 1 also accordingly
2017-04-05 |Updated Section 2.2.1 New Features with V7 R1 FR5 UCBE-10850
2018-01-08 | Updated Section 2.1 PBX Connection Options UCBE-14726
- add OpenScape 4000 V8
2018-01-15 | Updated Section 3.1 General Restrictions UCBE-14791
2018-01-26 |Updated Section 2.1 PBX Connection Options UCBE-14959
- add OpenScape Business V2
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Date Changes Reason
2018-03-29 | Updated: UCBE-15530
- Section 3.1 General Restrictions
- Section 1 General Considerations
2018-05-18 | Updated: UCBE-15941
- Section 2.2.1New Features released on V7 R1 FR5
- Section 2.6.2.1 Server
- Section 2.6.2.2 Clients
2018-05-24 | Updated: UCBE-15941
- Section 2.2.1New Features released on V7 R1 FR5 (has been
- Section 2.6.2.1 Server reopened)
- Section 2.6.2.2 Clients
2018-06-06 | Rename: UCBE-15941
- rename Section 2.2.1 to “New Features available on V7 R1 FR5 HF18” (has been
reopended)
2018-07-13 | Updated:
- Section 2.2.1 New Features released on V7 R1 FR5
- Section 2.6.2.2 Clients
- Section 6.1.2 Supported Exchange Versions
- Section 6.1.11 Connection to Exchange Server 2016/Exchange Online(O365)
- Section 6.1.11.1 Overview
2018-07-25 | - Section 6.1.11.1 Overview UCBE-16558
2018-07-30 |- new Section 5.6 Installation on Windows Server 2016 UCBE-16665
2018-09-17 |- Section 3.1 General Restrictions UCBE-17176
2018-11-23 |- Secction 3.1 eneral Restrictions UCBE-17882
2019-03-12 | Added: UCBE-18989
- Section 5.3 Running Xpressions Setup with OpenSSL files on Hotfix folder
- Section 5.3.1 Installing the SNMP feature
2019-03-15 | Updated: UCBE-19012
- Section 2.6.2.1 Server - Table 18
2019-04-08 | Updated: UCBE-19224
- Section 2.2.1 New Features released on V7 R1 FR5 UCBE-19214
- All references to “Dialogic” and replaced them with “Sangoma” throughout the document
2019-09-17 | Updated: UCBE-21060
- Section 2.6.2.1 Server
- Section 2.2.1 New Features released on V7 R1 FR5
2019-11-26 | Updated: UCBE-21820
- Section 2.6.2.2 Clients
2020-04-16 | Updated: UCBE-23069
- Section 3.1 General Restrictions
2021-04-27 | Updated: UCBE-26445
- Section 3.1 General Restrictions
2021-12-08 | Updated: UCBE-28858
- Section 3.1 General Restrictions
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History of Changes

Date Changes Reason

2025-03-06 |Updated sections: DOCLOC-9434
- 2.4.2 Web Conference Server (chapter removed)

- 2.4.5.5 Connecting a HiPath 4000 V6 and OpenScape 4000 V7
via SIP

- 2.4.5.5 Connecting a HiPath 4000 V6 and OpenScape 4000 V7
via SIP

- 2.4.6 Maximum Number of Cards and Channels

2025-10-24 | Updated sections: UCBE-38540
- 2.2 New Features

- 2.2.1 New Features released on V7 R1 FR5
-2.6.2.1 Server

- 2.6.2.2 Clients

A31003-S2370-S100-64-7620, 10/2025
OpenScape Xpressions V7 Release Notice, Service Documentation 13



History of Changes

A31003-S2370-S100-64-7620, 10/2025
14 OpenScape Xpressions V7 Release Notice, Service Documentation



General Considerations

1 General Considerations

OpenScape Xpressions V7 is an Intel-PC-based server solution that can be
operated on the Microsoft operating systems listed in Table 17 on page 57.

OpenScape Xpressions enables the user to manage his/her voice and fax
messages as well as e-mails in one mailbox, which can be accessed via
telephone as well as PC.

To control his/her calls and view call journals he/she can use the convenient
OpenScape Web Client as well as the optiClient Extensions as rich client.

Connected to one or several PBXs, the Multimedia Contact Center offers
conventional contact center features such as automatic call and message
distribution as well as Unified Messaging applications, for example voicemail, e-
mail, fax and SMS.

A user's presence profile and status can be controlled and represented. He/she
can exchange Instant Messages with other users. The client to be used for this
the optiClient 130.

OpenScape Xpressions can be deployed to conveniently extend meeting
requests by conferences in the user's preferred groupware. These conferences
can be staged as voice conferences, as web conferences or as combined voice/
web conferences.

OpenScape Xpressions is connected to the PBX via one (or several) Sy or Sy, tie
trunk(s) or via an IP/SIP link.

Message access by computer in OpenScape Xpressions occurs via IMAP4
clients by default or also via the clients of the e-mail systems that already exist at
the customer's - such as Microsoft Exchange Server 2003, Microsoft Exchange
Server 2007, Microsoft Exchange 2010, Lotus Domino (R6, R7 and R8) or SAP/
R3.

Alternatively, the OpenScape Xpressions Web Assistant is available as browser-
based client as well.

On the basis of OpenScape Xpressions several product versions exist which all
provide a different feature range.

In addition, OpenScape Xpressions offers:

* Connection to communications systems of the Unify GmbH & Co. KG via
CorNet-N, CorNet-NQ or CorNet-IP

* Networking with hardware-based PhoneMail networks
* Connection to HiPath User Management
e Connection to HiPath Fault Management

* A voice interface which corresponds to the one used in Hicom VMS.

A31003-S2370-S100-64-7620, 10/2025
OpenScape Xpressions V7 Release Notice, Service Documentation 15



General Considerations

16

¢ A voice interface which corresponds to the one for Hicom PhoneMail.
¢ The voice interface ERGO

* Display support at the telephone user interface via CorNet-N/NQ/IP at HiPath
4000

OpenScape Xpressions is a category A product.

IMPORTANT: Each feature not explicitly released in this release notice is not
released or requires a project-specific release (PSR). In the PSR process,
project-specific release may be granted or rejected for a feature. The process
may also result in a release notice modification to explicitly release a feature or
to explicitly deny the release.

Features that are released only project-specifically are not necessarily mentioned
in this release notice. Please read the respective setup and administration guides
or other instructions to see whether a feature has been released project-specifi-
cally. Example: the documentation for connecting the XPR to a Microsoft
Exchange server informs you about project-specific releases that exist to connect
the XPR to a Microsoft Exchange server. In Section 2.7, “Documentation”, on
page 69 you find a documentation list.

NOTE: Ifyou use the XPR server on real computers, a maximum of 20000 users
are supported, on virtual computers a maximum of 15000 users. If you want to
support more users, a project-specific release (PSR) is needed.

The load and dimensioning tool is a supplement to this release notice. It enables
calculating the load based on the available number of kernels, workstation
memory, harddisk memory, satellite computers, users, channels, the assumed
frequency of voicemail, fax documents, calls, the medium size of voicemails, fax
documents etc.
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2 Scope of Release

OpenScape Xpressions V7 with the build number mentioned in the release
notes on the setup medium is released with the restrictions according to
Chapter 3, “Restrictions” and the last modifications to the scope of
releases, which are also mentioned in the release notes on the setup
medium.

2.1 PBX Connection Options

NOTE: The OpenScape Voice PBX used to be called HiPath 8000 before
product version 3.1 R2.

Connection options for established customers

Using the PBXs listed in the following enables the same scope of services as with
HiPath Xpressions V4.0 SA10, but new features of OpenScape Xpressions V7
will not be supported. These systems support the connection via ISDN only.

e Hicom 300E V1.0, Hicom 300 V3.5

e Hicom 300E V2.0, Hicom 300 V3.6

e Hicom 300E V3.0 and V3.1

¢ Hicom 300 H V1.0

* Hicom Office Pro as of V2.2

¢ Hicom Office Com as of V2.2 (as of HE420K.10.428)
* Hicom 150 HV1.0

e HiPath 3000 of a version smaller than V5.0

e HiPath 4000 V1.0
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Using the PBXs listed in the following enables the same scope of services as with
HiPath Xpressions V5 R4, but new features of OpenScape Xpressions V7 will not
be supported.

Hicom 300E US'
HiPath 3000 V5.0
HiPath 4000 V2.0
HiPath 8000 V3.0
HiPath DX’
ROLM 9751"

The following systems support the new features of the OpenScape Xpressions
V7 release. Please obtain details about connection versions of the single PBXs
from Table 1 on page 21.

HiPath 3000 V6

HiPath 3000 V7

HiPath 3000 V8

HiPath 3000 V9

OpenScape Business V12

OpenScape Business V2

HiPath 4000 V6

OpenScape 4000 V73

OpenScape 4000 V8

HiPath 5000 (project-specific)

OpenScape Voice V7

OpenScape Voice V8

OpenScape Voice V9

Cisco Unified Communications Manager 6’
Cisco Unified Communications Manager 7'
Cisco Unified Communications Manager 8" and 8.6

Cisco Unified Communications Manager 9

N

. Without CTI support, i. e. Contact Center and Web Client may no longer be used, for example.
. OpenScape Business is the successor of HiPath 3000.
. As of version 7, “HiPath 4000” is named “OpenScape 4000”.
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Alcatel OmniPCX Enterprise (OXE) R7

Alcatel OmniPCX Enterprise (OXE) R8

Alcatel OmniPCX Enterprise (OXE) R9 and R9.1
Alcatel OmniPCX Enterprise (OXE) R10 and R10.1
Alcatel OmniPCX Enterprise (OXE) R11.0

other PBX (project-specific only)

Connection options for new customers

The following systems support the new features of the OpenScape Xpressions
V7. Please obtain details about connection versions of the single PBXs from
Table on page 21.

HiPath 3000 V6

HiPath 3000 V7

HiPath 3000 V8

HiPath 3000 V9
OpenScape Business V1’
HiPath 4000 V6
OpenScape 4000 V72
OpenScape 4000 V8

R8300 (project-specific only)

This is a HiPath 4000 with a reduced scope of service.
HiPath 5000 (project-specific only)

OpenScape Voice V7

OpenScape Voice V8

OpenScape Voice V9

Cisco Unified Communications Manager 6°

Cisco Unified Communications Manager 73

Cisco Unified Communications Manager 8%and 8.6
Cisco Unified Communications Manager 9

Alcatel OmniPCX Enterprise (OXE) R7

1. OpenScape Business is the successor of HiPath 3000.
2. As of version 7, “HiPath 4000” is named “OpenScape 4000”.
3. Without CTI support, i. e. Contact Center and Web Client may no longer be used, for example.
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Alcatel OmniPCX Enterprise (OXE) R8

Alcatel OmniPCX Enterprise (OXE) R9 and R9.1
Alcatel OmniPCX Enterprise (OXE) R10 and R10.1
Alcatel OmniPCX Enterprise (OXE) R11.0

other PBX (project-specific only)
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Overview PBXs / connection version

(VolP via gateway HG1500/CorNet-IP)

yet

PBX ISDN VolP T.38 Fax G.711 Fax Voice
conference

HiCom 300E (US-Version) Unavailable | Unavailable Unavailable |Unavailable

HiPath 3000 V5 Not Not released Not Unavailable’

(VolP via gateway HG1500/CorNet-IP) yet yet

HiPath 3000 V6 Not Not released Not Unavailable’

(VolIP via gateway HG1500/CorNet-IP) yet yet

HiPath 3000 V7 V4 V4 Not released | Unavailable'

HiPath 3000 V8
(VolIP via gateway HG1500/CorNet-IP)

v

v

Not released
yet

v

HiPath 3000 V9
(VolP via gateway HG1500/CorNet-IP)

v

v

Not released
yet

v

ANEENENE S SN N LN

(VolP via gateway VHG35xx/SIP°%)

OpenScape Business V1 Not released | Not released Not released 8
(VoIP via gateway HG1500/CorNet-IP) yet yet yet

OpenScape Business V2 Not released | Not released Not released 8
(VolP via gateway HG1500/CorNet-IP) yet yet yet

HiPath 4000 V6 with PCI slot hardware? V4 V4 Not released | /4 °
(VolIP via gateway HG35xx/CorNet-IP or yet

sIP3)

HiPath 4000 V6 without PCI slot Unavailab | ./ V4 Not released | /43
hardware? le yet

(VolP via gateway VHG35xx/SIP°)

OpenScape 4000 V7° with PCI slot V4 V4 V4 Not released | /43
hardware? yet

(VolP via gateway HG35xx/CorNet-IP or

sIPd)

OpenScape 4000 V7°without PCI slot Unavailab | ,/ V4 Not released | ./ 42
hardware? le yet

OpenScape 4000 V8 with PCI slot
hardware?

(VolIP via gateway HG35xx/CorNet-IP or
SIP®)

v

Not released
yet

OpenScape 4000 V8 without PCI slot Unavailab | ,/ V4 Not released |,/

hardware? le yet

(VolP via gateway VHG35xx/SIP°)

OpenScape Voice V7 Unavailab | ,/ V4 Not released |,/
le yet

OpenScape Voice V8 Unavailab | , / V4 Not released |,/
le yet

OpenScape Voice V9 Unavailab | ,/ V4 Not released |,/
le yet

Table 1 Overview PBXs / connection version
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conferencing

PBX ISDN VolP T.38 Fax G.711 Fax Voice
conference
HiPath DX V7.0 ‘/ Unavailable |Unavailable Unavailable |Unavailable
ROLM 9751 ‘/ Unavailable | Unavailable Unavailable |Unavailable
Cisco Unified Communications Manager 6 | Unavailab ‘/for H.323 Not released ‘/
le via XCAPI/  |Restricted” for | yet
ISDN APL® + |H.323 via XCAPI/
SIP for audio |ISDN APL®

Cisco Unified Communications Manager 7 | Unavailab ‘/ ‘/ Not released
le yet

Cisco Unified Communications Manager 8 | Unavailab ‘/ ‘/ Not released
le yet

Cisco Unified Communications Manager | Unavailab ‘/ ‘/ Not released

8.6 le yet

Cisco Unified Communications Manager 9 | Unavailab ‘/ ‘/ Not released

le yet

Alcatel OmniPCX Enterprise (OXE) R7 ‘/ Not Not Not

yet yet yet

Alcatel OmniPCX Enterprise (OXE) R8 V4 V4 V4 Not

yet

Alcatel OmniPCX Enterprise (OXE)R9 | ./ V4 V4 Not
and R9.1 supported

Alcatel OmniPCX Enterprise (OXE) R10 |/ V4 V4 Not
and R10.1 supported

Alcatel OmniPCX Enterprise (OXE) R11.08 |/ V4 V4 Not
supported

SNEENEENENENENENENEN

Table 1

Overview PBXs / connection version

1 Voice conferences are not supported because SIPcontrol is not suported anymore by Sangoma.
2 PCl slots with ISDN boards of the Unify GmbH & Co. KG have been sold for new installations of a HiPath 4000 up to version V5. A

HiPath 4000 with this hardware can be upgraded to hardware for HiPath 4000 V6 or OpenScape 4000 V7 by adding a DSCXL-V2 board.
A connection from the XPR server to hardware upgraded in this way supports CorNet-IP and SIP, but no SIP-Q.

If your hardware for HiPath 4000 V6 or OpenScape 4000 V7 is completely new, a purely server-based solution is on hand (VolP switch).
This hardware does not include any ISDN boards. It has been sold as of HiPath 4000 V6 RO. This hardware supports SIP but no
CorNet-IP and SIP-Q.

We do not recommend to connect a HiPath 4000 V6 RO via SIP. If you wish to use SIP we recommend an upgrade of the HiPath 4000
to V6 R1, OpenScape 4000 V7 or later.

4 Audio conferences have not been released for HiPath 4000 V6 RO yet.
5 As of version 7, “HiPath 4000” is named “OpenScape 4000”.
6 XCAPI has been released project-specifically only.
7 Released for the gateways C2600 and C2800 only
8 In case of problems with outcalls from XPR via SIP - especially after an upgrade from Alcatel OmniPCX Enterprise R9 or lower to
R11.0 - check whether the parameter values for SIP Ext Gateway have been set as follows:
SDP in 18x = false
Support Re-invite without SDP = false
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Scope of Release
New Features

Compared to the previous version, the following features have been added or
revised with OpenScape Xpressions V7:

2.2.1 New Features released on V7 R1 FR5

Reference Summary Released on
Microsoft Office 2024 and 365 Apps support for documents | XPR V7R1 FR5 HF43
conversion:

*  Word

* Excel

*  PowerPoint

Windows Server 2022 support for Xpressions Server XPRV7R1 FR5 HF42
Microsoft Office 2021 support for documents conversion: | XPR V7R1 FR5 HF42
*Word

* Excel

* PowerPoint

Exchange 2019 Integrated Messaging support XPRV7R1 FR5 HF33

NA16527118 | Windows Server 2019 support for Xpressions Server XPR V7R1 FR5 HF31

RQ00041467 | Exchange 2016 PublicFolders support for OutlookForms | XPR V7R1 FR5 HF25
Microsoft Office 2016 support for documents conversion: | XPR V7R1 FR5 HF18
* Word
* Excel
* PowerPoint
Updated WebAssistant web browsers supported versions: | XPR V7R1 FR5 HF 18
* Internet Explorer 11
* Mozilla Firefox 59.0
* Safari 5.1.7 (only for Windows)

* Google Chrome 66.0

NA15525275 | OutlookForms Fax Cover support XPR V7R1 FR5 HF13
Windows Server 2016 support for Xpressions Server XPR V7R1 FR5 HF13
Exchange 2016 Integrated Messaging support XPR V7R1 FR5 HF7
Microsoft Office 2016 support for: XPR V7R1 FR5 HF5
* OutlookForms
* VMPlayer
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New Features

Reference

Summary

Released on

Microsoft Windows 10 support for: XPR V7R1 FR5 HF5
* Application Builder

* WebAssistant
* QOultookForms
* VMPlayer

» Server Monitor Application

* Notes Forms

Microsoft Edge Browser support for WebAssistant XPR V7R1 FR5 HF5

NA14523582

OutlookForms "From" field support XPR V7R1 FR5 HF4

Exchange Online (0O365) Integrated Messaging support | XPR V7R1 FR5 HF3

Windows Server 2025 support for Xpressions Server XPR V7R1 FR5 HF43

24

2.2.2 New Features with V7 R1 FR4

VMware ESXi

VMware Data Protection is supported for VMware ESXi V5.5 as well (see Sec-
tion 2.6.2.1, “Server”, on page 57).

XPR on VMware ESXi for 15000 users needs a project-specific release. This is
possible for VMware ESXi V5.5 as well.

Microsoft Exchange Server 2013

A direct connection from the XPR server to a Microsoft Exchange Server 2013 is
supported.

MSPTSP

The sentence “MSPTSP is not supported on 64-bit operating systems.” has been
removed.

MAPI fax printer driver

MAPI fax printer drivers are supported for terminal server environments with
Citrix.

Client Applications

Support of the Outlook Extensions for the 64-bit version of Outlook 2010 and
Outlook 2013 on 64-bit operating systems

Newly supported browsers

Internet Explorer 11 is supported by Xpressions WebClient when running in
Compeatibility View Mode.

A31003-S2370-S100-64-7620, 10/2025
OpenScape Xpressions V7 Release Notice, Service Documentation



Scope of Release
New Features

2.2.3 New Features with V7 R1 FR3

Newly supported PBXs

OpenScape Business V1, OpenScape Voice V8, OpenScape 4000 V7 and
Alcatel OmniPCX Enterprise (OXE) R11.0 are supported.

NOTE: As of version 7, “HiPath 4000” is named “OpenScape 4000”.

Newly supported operating systems

* The following operating systems are supported by the XPR server as well:

*  Without Windows cluster

Windows Server 2012 R2 Datacenter Edition
Windows Server 2012 R2 Standard Edition

Windows Server 2012 R2 Standard for Embedded Systems -
Telecommunications

Windows Server 2008 R2 SP1 for Embedded Systems - Telecommu-
nications

Windows Server 2003 R2 SP2 Datacenter Edition

e With a Windows cluster

Windows Server 2012 R2 Datacenter Edition

Windows Server 2012 R2 Standard for Embedded Systems -
Telecommunications

Windows Server 2008 R2 SP1 for Embedded Systems - Telecommu-
nications

Windows Server 2003 R2 SP2 Datacenter Edition

* Microsoft Windows 8.1 Pro Edition is supported for clients.
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IBM Notes/IBM Domino

IBM Notes 9.0 Social Edition (Basic Configuration) and IBM Domino 9.0 Social
Edition are supported.

NOTE: The names of former versions of IBM Notes and IBM Domino are Lotus
Notes and Lotus Domino.

Microsoft Exchange Server 2013

A connection from the XPR server to a Microsoft Exchange Server 2013 via a
Microsoft Exchange 2007 gateway is supported.

A project-specific release is required for a connection from the XPR server to a
Microsoft Exchange Server 2013 via a Microsoft Exchange 2010 gateway.

Microsoft Office

Microsoft Office 2013 is supported.

VMware ESXi V5.5

VMware ESXi V5.5 is supported (see Section 2.6.2.1, “Server”, on page 57).

2.2.4 New Features with V7 R1 FR2

Newly supported browsers

Internet Explorer 10 is supported by the WebClient as well.

2.2.5 New Features with V7 R1 FR1

Newly supported operating systems

Windows Server 2008 R2 Datacenter Edition and Windows Server 2012 are
supported by the XPR server and Windows 8 is supported by the clients (see
Table 17 on page 57, “Released operating systems for the XPR server on real
and virtual computers” and Section 2.6.2.2, “Clients”, on page 66).

VMware configuration parameters

VMware configuration parameters for virtual computers have been specified
(see Table 18 on page 60, “Virtual Machine configuration parameters”).

Catalan

Catalan is supported for specific features (see Section 2.5, “Languages”, on
page 55).

A31003-S2370-S100-64-7620, 10/2025
OpenScape Xpressions V7 Release Notice, Service Documentation



Scope of Release
New Features

Smaller fix release package

You can create a setup medium for an upgrade to a fix release with help of an old
setup medium and additional EXE files. This applies only for an upgrade to a fix
release on a non-cluster system and for kernel computers (not for satellite
computers). You perform the actual upgrade as usual.

Silent upgrade

XPR V6 R2 64-bit, XPR V7 RO 64-bit and XPR V7 R1 64-bit can be upgraded
silently to XPR V7 R1 FR1, i e. no user interaction is needed during the upgrade.
Restrictions are described in point 47 on page 77.

Multi tenant

New configuration field for configuring a tenant-specific welcome greeting.

Exchange connection

* New option in the Exchange Fail-Safe Tool for skipping the transport directory
test.

* New option in the Exchange Fail-Safe Tool for an advanced system property
check with the following tests after setting up the connectors:

— Checking which Exchange Server version is active in the system.
— Checking whether a connection can be set up to this Exchange server.

— Checking whether the core services such as System Attendant, Mail
submission, RPC Client operate on the Exchange server.

— Checking whether the registry entries are consistent after the ExXUMApI
installation.

— Checking whether the registry entries are consistent after the E2k7Apl
installation.

— Checking the CAS Array and DAG AD configuration.

— Checking whether the service account has a valid mailbox in case of a
connection to Exchange Server 2010.

— Result dialog displaying tips and hints concerning the XPR integration in
an Exchange environment.

» E2k7Apl start/stop configurable independently from the current watchdog
settings via registry value.

» Selecting the transport directories already during the E2k7Apl setup.

* Browse button for selecting the service account in the Exchange Fail-Safe
Tool added.

*  ExUmApl improvements with regard to detecting missing installation
requirements to avoid login problems after the installation.
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Newly supported browsers

Internet Explorer 10 is supported by the WebAssistant but not by the WebClient.

2.2.6 New Features with V7 R1

PBXs
The HiPath 3000 V9 is supported also.
Lotus Domino/Notes
Lotus Domino 8.5.3 and Lotus Note 8.5.3 are supported.
Newly supported browsers
*  WebClient
— Internet Explorer 9
— Firefox up to 3.6
*  Web Assistant
— Internet Explorer 9
— Firefox 16.0.1
— Safari 5.1.7
— Chrome 22.0

Web Assistant

The WebAssistant can be configured to prevent playing voicemails on the PC.

WebClient

The journal also displays entries of unavailable phones, for example of a
softphone on a shut-down computer.

PhoneMail/Ergo

The configuration of the Trusted Transfer Mode has been revised.

IP APL

The Fax G3 protocol parameters UseFaxldAsOAD, InsertMidHI and
CheckPageNumbers are supported by the IP APL also.

Multi tenants

* Voice guide (Vogue) support

If a user deploys the voice guide on an XPR server with several tenants, only
users of the same tenant are returned if a corresponding configuration has
been performed. Such settings are valid for an SIP connection only.
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* The location and tenant settings of the XPR server can be configured with
help of the FI APL and a configuration file. To enable this, the XprConfig.e
configuration script, being able to process appropriate configuration files, is
shipped for the FI APL. Such settings are valid for an SIP connection only.

Application Builder

The name dialing control of the Application Builder can use a filter (SAAFILTER),
so that e. g. the Automated Attendant searches for names in a subsidiary and not
in the entire company.

Web APL

The HTTP protocol is disabled by default. This affects the IP-Phone wizard and
the SNMP agent. Both of them require this protocol. If you need these
applications, you must reactivate the protocol.

Wall APL and ACD Supervisor

The following features are not supported anymore:
* WallAPL

* ACD Supervisor

VMware vMotion

VMware vMotion is supported with restrictions (see Section 2.6.2.1, “Server”, on
page 57).

Data backup and restore on virtual computers

Data backup and restore is supported on virtual computers with Windows Server
2008 R2 by the following means:

* Microsoft Windows Server Backup Features

* Veeam Backup & Replication 6.1

*  VMware 5.1 VDP (VMware Data Protection) on VMware ESXi V5.x
*  VMware VDR (VMware Data Recovery) on VMware ESXi V4.x
See point 7 on page 63 for details.

VMware ESXi V5.1

VMware ESXi V5.1 is supported without special restrictions (see Section 2.6.2.1,
“Server”, on page 57).

2.2.7 New Features with V7 R0

Supported operating systems

Only 64-bit operating systems are supported for the XPR server (see Table 17
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on page 57). Windows 7 Professional is supported for the XPR server with
restrictions.

Upgrading MRS 8.xx to XPR 7
When upgrading MRS 8.xx to XPR 7, the following components are installed:

e ABCAPL
* LPRAPL
« VMAPL
» ERGO

The ERGO configuration was added to the Web Assistant. You can use the
clients as MRS clients until the next upgrade during which the branding is
changed to OpenScape Xpressions.

Installation

No DVDs but a USB stick is used as setup medium.
Connecting PBXs

The following connections are supported:

¢ HiPath 4000 V6 R1/R2 via CorNet-IP or SIP

PCI slots with Sangoma ISDN boards have been sold for new installations of
a HiPath 4000 up to version V5. You can upgrade this hardware to hardware
for HiPath V6 by adding a DSCXL-V2 board.

If you have entirely new hardware for HiPath 4000 V6, a purely server-based
solution is on hand (VolP switch). This V6 hardware does not include any
ISDN boards. It has been sold as of HiPath 4000 V6 RO. This hardware
supports only SIP but no CorNet-IP and no SIP-Q.

¢ OpenScape Voice V6

¢ OpenScape Voice V7

¢ Cisco Unified Communications Manager 8.6

* Alcatel OmniPCX Enterprise (OXE) R9.1

¢ Alcatel OmniPCX Enterprise (OXE) R10 and R10.1
TTS and ASR

TTS is executed by Nuance Vocalizer for Networks 5 and ASR by Nuance
Recognizer 9.

VM2TXT APL

This new APL enables converting a voicemail into written text and further
processing it. This APL can be installed on a Windows cluster (see point 30 on
page 91). Please consider the restrictions outlined in point 38 on page 75.
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Connecting OpenScape UC Application V6 R0
Connecting OpenScape UC Application V6 RO is supported

Microsoft SQL Server

Microsoft SQL Server 2008 and SQL Server 2008 R2 are supported in the
following editions:

» Datacenter Edition
* Enterprise Edition
» Standard Edition

*  Workgroup Edition
* Web Edition

e Developer Edition

* Express Edition

Microsoft Exchange Server

*  Support of multi-connector operation for Exchange Server 2003, 2007 and
2010

* Client Access Server Array support for setting up the connectors for
Exchange Server 2010

» Database Availability Group support for setting up the connectors for
Exchange Server 2010

VMware ESXi V5.1

VMware ESXi V5.1 is supported with restrictions, see Section 2.6.2.1, “Server”,
on page 57.

ERGO

You can connect ERGO of the XPR server to the voiceportal of the OpenScape
UC Application using the Trusted Transfer Mode. This expands ERGO by the
corresponding OpenScape UC Application features (see also point 37 on page
75).

Multi tenant

e Caller guide support

If a user deploys the caller guide on an XPR server with several tenants, only
users of the same tenant are returned.

* Tenant management

User group Tenant Supervisor Group has been introduced. Users of this
group may administer users within a tenant and have the following privileges:
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Acces to menu Server settings > User Administration except for
creating a new user group

Creating a user
Assigning a user to a tenant

Assigning a user to a tenant supervisor group

New user group Help Desk Group

User group Help Desk Group has been introduced with the following privileges:

e Creating a user

* Assigning a user to the Helpdesk group

* No access to the XPR server configuration

¢ Restricted access to menu Server settings > User Administration:

Unlocking the user

Deleting the MWI status
Updating the MWI status
Resetting the PIN

Resetting the password
Resetting notification settings
Resetting voicemail settings

Acting on behalf of

Client Applications

Support of the Outlook Extensions for the 32-bit version of Outlook 2010 on 64-
bit operating systems

Java runtime environment (JRE)
The SUN-JRE has been replaced with the IBM-JRE.

Web Assistant

* Requesting a new PIN can be configured.

e All available user licenses and those already used are displayed.

¢ True Single Sign On (SSO)

A user of the same domain as the XPR server is authenticated after the login
to the domain and he/she does not need to retype his/her password.
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This is valid for using the browsers Internet Explorer 6 or later or Firefox 4 or
later on the client side and for using Microsoft Windows Server 2003 or 2008
as domain controllers. If other domain controllers are used, a special
configuration might be necessary to activate the Kerberos authentication
protocol.

SNMP traps for errors and warnings

XPR uses SNMP (Simple Network Management Protocol) traps not only for
sending system information but also for sending error messages and warnings to
the management center.

Over capacity license warning

When a license violation was detected, a warning used to be written to the XPR
log. Now, an error is written. In addition, an entry is made in the Microsoft event
log. If SNMP is used, an SNMP trap is sent as well.

Installing LocalFormsSmtp without Outlook profile

Setting up LocalFormsSmtp (OpenScape Xpressions optiClient Extensions) does
not require the Outlook profile of the installing user anymore. This is not valid for
publishing LocalFormsSmtp.

Support of the OpenScape Voice Trace Manager

XPR sends logging information to the OpenScape Voice Trace Manager
(OSVTM), which collects this information centrally.

Conferences

* Web conferences can be accessed from the Outlook or Lotus Notes plug-in
within a specific period (entrance grace period) prior to the scheduled web
conference start.

» If participants are still in a web conference at a specific time (termination
grace period) before the web conference ends, the web conference is
prolonged by 30 minutes if the required resources can be reserved. If no
participants are in the web conference at this time, it ends as scheduled.

» Statistics raw data of conferences can be used for reporting as in the
OpenScape UC Application V6 RO. Such statistics raw data comprise among
other things a conference's creation and start date and the times at which
participants joined or left a voice or web conference.

Resetting a PIN

You can reset a PIN by mail from Lotus Notes, Microsoft Exchange or by SMTP.
The user clicks on PIN forgotten and receives a message that he/she needs to
confirm. He/she then receives a second message with the new, arbitrary PIN. The
user enters this PIN to log in and changes it.
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Crystal Report Runtime Engine

This runtime engine is available on the setup medium (USB stick) and installed in
the scope of a ReportScheduleAPL setup.

XPR version in the program list

The list of programs installed on the Windows computer displays the XPR
version.

Security checklist

The new documentation called OpenScape Xpressions Security Checklist serves
as basis for defining the security settings when you expand systems, put them
into operation or update their software. The checklist supports the service in the
direct and indirect channel when making arrangements with the customer and for
documenting decisions taken.

MMCC, x-Kit, TNG and SAPbyDesign

The following features are not supported anymore:
e  MMCC (Multimedia Contact Center)

o x-Kit

* TNG (The Next Generation)

e SAPbyDesign

For details see point 39 on page 76.

Application conversion

Microsoft Office 2010 can be used for the application conversion in the 64-bit
version also.

No new hardware. See the following section for supported hardware.
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2.4 Hardware Requirements

2.4.1 Server

Sangoma ISDN boards:

IMPORTANT: Attimes, Sangoma uses different version numbers for the same
board. For example, the hardware description features a specific version number
for a board, but in the Sangoma Diva Configuration Manager you find another
version number for the same board. The version numbers used for Sangoma
ISDN boards in this XPR V7 release notice are always the version numbers
specified in the Sangoma Diva Configuration Manager!

IMPORTANT: Connecting OpenScape Xpressions via the QSIG protocol instead
of CorNet is supported. Such a QSIG connection is enabled by using any
Sangoma Euro ISDN board that supports QSIG. All Sangoma CorNet-N and
Sangoma CorNet-NQ boards are Euro ISDN boards, so they support QSIG.

IMPORTANT: You cannot use a Sangoma-PRI board for two different protocols,
e. g. QSIG and CorNet-NQ, at the same time. Instead, use two Sangoma-PRI
boards: one for the first and one for the second protocol.

If, for example, you use QSIG for SIP control and CorNet-NQ for features specific
to Phonemail, you need two Sangoma-PRI boards: one for QSIG and one for
CorNet-NQ.

The following Sangoma ISDN boards are supported by the drivers (version
8.5.10) on the XPR V7 setup medium:

* Diva BRI boards (version 2.0)
e Diva BRI-2 PCle
e Diva 4BRI-8 PCI
¢ Diva 4BRI-8 PCle
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e Diva PRI/E1/T1 boards (version 3.0)

Diva PRI/E1/T1-8 PCI
Diva PRI/E1-30 PCI
Diva PRI/E1-30 PCle
Diva PRI/T1-24 PCI
Diva PRI/T1-24 PCle

e Diva PRI/E1/T1 boards (version 4.0)

Diva V-PRI/E1-30 PCI

Diva V-PRI/E1-30 PCle

Diva V-PRI/T1-24 PCI

Diva V-PRI/T1-24 PCle

Diva V-2PRI/E1-60 PCI

Diva V-2PRI/T1-48 PCI

Diva V-4PRI/E1-120 PCI
Diva V-4PRI/T1-96 PCI

Diva V-1PRI/T1-24 PCle HS
Diva V-1PRI/E1-30 PCle HS
Diva V-2PRI/T1-48 PCle HS
Diva V-2PRI/E1-60 PCle HS
Diva V-4PRI/T1-96 PCle HS
Diva V-4PRI/E1-120 PCle HS
Diva V-1PRI/E1/T1-30 CorNet for Unify GmbH & Co. KG

Diva V-1PRI/E1/T1-30 Fax enabled CorNet for Unify GmbH & Co. KG
HS: Half size

IMPORTANT: Sangoma ISDN PRI boards of version 2.0 are not supported.

Mixed operation between different BRI or PRI cards as well as mixed operation
of BRI and PRI cards on a server computer is not released.

The boards released for parallel operation of XPR and HiPath ProCenter V7.0
GP4 are listed in Section 3.10, “Restrictions on Co-residency with HiPath
ProCenter V7.0 GP4”, on page 86.
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An SMS send station and maybe also an interface extension board are required
for the SMS by direct GSM transmission.

On the Hicom side, DIUS2/DIUN2/DIUN4 ports are required for a connection via
S, (Hicom 300 or HiPath 4000 only) or STMD/STMD2/STLS ports are required
for a connection via Sy (Hicom 300, Hicom Office Pro/COM, HiPath 3000).

A detailed description of all the hardware components which can be installed can
be found in the OpenScape Xpressions Akabam (section 2).
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Standard PC (in case of new installations):

NOTE: If you use real computers for the XPR server, a maximum of 20000 users
is supported, on virtual computers a maximum of 15000. If more users are to be
supported, a project-specific release (PSR) must be applied for.

The load and dimensioning tool is a supplement to this release notice. It enables
calculating the load based on the available number of kernels, workstation
memory, harddisk memory, satellite computers, users, channels, the assumed
frequency of voicemail, fax documents, calls, the medium size of voicemails, fax
documents etc.

NOTE: Please obtain the hardware requirements for an upgrade from the
OpenScape Xpressions Upgrade installation guide.

Processor

¢ Atleast Intel Pentium 4 (or compatible) (Xeon processor or dual core system),
at least 2 GHz

* Using T.38 Fax on more than two parallel lines requires a server with at least
2 GHz, at least 2 GB RAM and at least one dual core CPU.

¢ For conferencing usage one additional core per 50 voice channels

¢ Using the OpenScape Web Client requires a powerful processor depending
on the number of users and sessions. The performance requirements per
OpenScape Web Client user are approximately twice as high as for an
optiClient 130 user.

RAM requirements:
¢ 2 GB (recommendation: 4 GB)
* incase of TTS usage

e additional 100 MB per installed TTS voice of Nuance Vocalizer for
Networks and

* additional 2MB per channel

at least, however, 1 GB in addition
* in case of ASR usage 512 MB in addition
¢ in case of conferencing usage 2 GB in addition

* in case of OpenScape Web Client usage at least 1 GB in addition
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Hard disks
* 2 hard disks with at least 100 GB (IDE or SCSI) each.

* Be sure that the partition on which the XPR server software is installed has a
minimum size of 10 GB. Additionally, the target path must not contain any
blanks (e. g. c:\OpenScape Xpressions\xpr)!

* Second hard disk for data backup recommended

LAN

* When the XPR and web conference server are operated in parallel on the
same computer, the following requirements must be complied with:

e Port 80 (TCP) and port 5000 (TCP) must be accessible.

Additionally required hardware:

* Diva ISDN board(s) by Sangoma, if no connection is to be set up via IP.

e Optionally SMS via LAN box (SMS feature)

A LAN box is a box that has an Ethernet interface and a serial interface. The
Ethernet interface is connected to the Ethernet interface of the XPR server
via the Ethernet. The serial interface of the LAN box thus represents a
dislocated serial interface of the XPR server. Deploying a LAN box is useful
if the radio coverage for sending and receiving short messages is insufficient
in the XPR server's location but is sufficient in the place where the LAN box
is situated.

* The adapter cable between DIU connection and PC card with RJ48 sockets
must be prepared by the regional office. The connection configuration can be
found in the appendix to the installation guide.

* The Sj cable with RJ45 connection must be provided by the regional office.
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2.4.2 OpenScape Xpressions optiClient Extensions

The OpenScape Xpressions optiClient Extensions consist of the
e CTI client optiClient 130 and the
* Outlook Extensions (icon and message forms)

The OpenScape Xpressions optiClient Extensions are exclusively intended for
operation on a client computer.

optiClient 130 is compatible to Microsoft Dynamics CRM 3.0 and 4.0 and offers
an improved support for Citrix terminal server and Microsoft terminal server,
because it is no longer limited to 10 users per terminal.

IMPORTANT: If optiClient 130 is to communicate as SIP softphone via a VPN
connection, the QoS packet planner must not be installed under the Windows
operating system.

NOTE: The support of optiClient 130 in Microsoft terminal server- respectively
Citrix-MetaFrame environments is restricted to the use of CTl features. The client
can then not be used as SIP telephone.

NOTE: Expansion limits for CTI

The load limitation for CTI usage strongly depends on the individual telephony
behavior of the user. If standard conditions apply (average of 10 monitored
contacts per CTI client and 20 calls per user and day, no bulk calls at a specific
time of day), there can be up to 1000 simultaneous CTI users. An increase of this
number requires specific analysis and a project-specific release.

NOTE: Ifyou use real computers for the XPR server, a maximum of 20000 users
is supported, on virtual computers a maximum of 15000. If more users are to be
supported, a project-specific release (PSR) must be applied for.

The load and dimensioning tool is a supplement to this release notice. It enables
calculating the load based on the available number of kernels, workstation
memory, harddisk memory, satellite computers, users, channels, the assumed
frequency of voicemail, fax documents, calls, the medium size of voicemails, fax
documents etc.
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2.4.2.1 Software Requirements
For usage with Microsoft Outlook

*  Microsoft Outlook XP SP2 or SP3

*  Microsoft Outlook 2003

*  Microsoft Outlook 2007

*  Microsoft Outlook 2010

For usage with Lotus Notes

* Lotus Notes Client 6.0.x

* Lotus Notes Client 6.5.x

* Lotus Notes Client 7.0.x

* Lotus Notes Client 8.0.x

* Lotus Notes Client 8.5.0 up to 8.5.3

* |IBM Notes Client 9.0 Social Edition (Basic Configuration)

NOTE: Ifyouuse IBM Notes 9.0 Social Edition (Basic Configuration), use the
mail templates for Lotus Notes 8.

2.4.2.2 Hardware Requirements

Windows XP Professional SP2 and SP3

The recommended hardware configuration allows operating the software and
several other applications simultaneously without significant loss of performance.

* Atleast Pentium 4 with 1,3 GHz or compatible processor of the same
performance

* Atleast 512 MB RAM

Windows 7, Vista, Server 2003 and Server 2008

Please adhere to the hardware recommendations by Microsoft for the respective
operating system.
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2.4.3 Application Builder Computer

The Application Builder computer has to comply with the following minimum
requirements:

e CPU with 512 MB RAM and more than 1 GHz

We recommend a computer being just as powerful as an Intel Core T7200
with 2 GHz and 2 GB RAM.

¢ Every Windows operating system the following software can run on is
supported:

Java runtime environment 6 or later

Eclipse Rich Client Platform (RCP;
see http://wiki.eclipse.org/index.php/Rich_Client_Platform)

Standard Widget Toolkit (SWT, see http://wiki.eclipse.org/SWT)
Graphical Editing Framework (GEF, see http://www.eclipse.org/gef/)
Draw2D

NOTE: This software need not be set up before the Application Builder
installation. It is shipped with the XPR setup medium and set up automatically
in the course of the Application Builder installation.

NOTE: Forexample, the current versions of the operating systems Windows
Server 2008, Windows XP and Windows Vista comply with such require-
ments.
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2.4.4 Upgrading Limits with Connection via IP

Depending on the HiPath -3xxx model, between two and eight HG1500 may be
implemented.

An IP APL can be operated in parallel to an ISDN APL on one computer.

One IP APL cannot support two protocols of the infrastructure layer (e. g. H.323,
CorNet-IP or SIP) in parallel. However, the following example scenarios are well
possible, provided the connected PBX supports the mentioned protocols:

» Parallel operation of Voice via H.323 and T.38 Fax via H.323
* Parallel operation of Voice via SIP and T.38 Fax via SIP.

You find details on this in the OpenScape Xpressions Server Administration
administrator documentation.

Multiple installation of the IP APL on one computer has been released.

2.4.4.1 Cornet-IP

An IP APL may be addressed by an arbitrary number of HGs, but can transmit
outgoing calls only via a specific HG. 30 channels for the IP APL on a kernel
computer and 60 channels for an IP APL on a satellite computer are supported
for the G.711 codec.

Satellite system specialities
Max. number of channels in the entire system: 300
Max. number of channels in the kernel: 30

Max. number of channels per satellite: 60
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2.4.4.2 HiPath 37xx with HG1500

The channels are provided by Digital Signaling Processors (DSP). A DSP of an
HG1500 can process a maximum of 8 voice channels. An HG1500 can be
furnished with up to four DSPs and supports up to 32 voice channels. On the
basic expansion level the HG1500 has already 2 DSPs .

Number of simultaneous Number of simultaneous
channels on the basic channels on the highest
expansion level of the HG1500 | expansion level of the HG1500 (4
(2 DSPs) DSPs)

Voice-only 16 32

Table 2 Number of simultaneous Channels

In case of mixed Voice/T.38 Fax operation the maximum number of T.38 Fax
channels is limited by the HG1500. For one HXGM3 as well as STMI2, three T.38
Fax channels are possible and for one HXGS3 as well as HXGR3, two T.38 Fax
channels are possible. The number of channels available for Voice is reduced by
the number of channels used for T.38 Fax. Please note the increased minimum
hardware-requirements for using T.38 Fax on more than two parallel lines (see
Section 2.4.1, “Server”, on page 35).

Connection scenarios from the OpenScape Xpressions V7 view

The following table shows the maximum number of channels for voice (all values
in the table refer to the highest expansion stage of the HG1500). We differentiate
between the number of channels for incoming and outgoing calls.

Number of XPR PCs | Number of | Channels voice-only

Kernels | Satellites e In total Kernel | Satellites
s

1 0 1 30 30 0

1 1 3 90 30 60

1 2 4 150 30 120

1 3 5 210 30 180

Table 3 Number of Channels for incoming Calls

Number of XPR PCs | Number of | Channels voice-only
Kernels | Satellites HES In total Kernel | Satellites
s

1 0 1 30 30 0

1 1 2 64 30 34

1 2 3 96 30 66

1 3 4 128 30 98

Table 4 Number of Channels for outgoing Calls
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2.4.4.3 HiPath 38xx with HG1500SAPP

The channels are provided by Digital Signaling Processors (DSP). A DSP of an
HG1500SAPP can process a maximum of 16 voice channels. An HG1500SAPP
can be furnished with up to four DSPs and supports up to 64 Voice channels. On
the basic expansion level the HG1500SAPP has already 2 DSPs.

Number of simultaneous Number of simultaneous channels
channels on the basic on the highest expansion level of
expansion level of the the HG1500SAPP (4 DSPs)
HG1500SAPP (2 DSPs)

Voice-only 32 64

Table 5 Number of simultaneous Channels

In case of mixed Voice/T.38 Fax operation the maximum number of T.38 Fax
channels is limited by the HG1500. For one HXGM3 as well as STMI2, three T.38
Fax channels are possible and for one HXGS3 as well as HXGR3, two T.38 Fax
channels are possible. The number of channels available for Voice is reduced by
the number of channels used for T.38 Fax. Please note the increased minimum
hardware-requirements for using T.38 Fax on more than two parallel lines (see
Section 2.4.1, “Server”, on page 35).

Connection scenarios from the OpenScape Xpressions V7 view

The following table shows the maximum number of channels for voice (all values
refer to the highest expansion stage of the HG1500SAPP). We differentiate
between the number of channels for incoming and outgoing calls.

Number of XPR Number of |Channels voice-only

PCs HGs

Kernel | Satellites In total Kernel | Satellites
s s

1 0 1 30 30 0

1 1 2 90 30 60

1 2 2 128 30 98

1 3 3 192 30 162

Table 6 Number of Channels for incoming Calls

Number of XPR Number of | Channels voice-only

PCs HGs

Kernel | Satellites In total Kernel | Satellites
s s

1 0 1 30 30 0

1 1 2 90 30 60

Table 7 Number of Channels for outgoing Calls
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Number of XPR Number of | Channels voice-only

PCs HGs

Kernel | Satellites In total Kernel |Satellites
s s

1 2 3 150 30 120

1 3 4 210 30 180

Table 7 Number of Channels for outgoing Calls
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2.4.4.4 HiPath 4000 with HG35xx

The HiPath 4000 V3 loadware must at least be of version V3.0 R7.4.0. It contains
the loadware for the HG35xx

The channels are provided by Digital Signaling Processors (DSP). A DSP of an
HG35xx is able to process a maximum of 30 voice channels. An HG35xx is
always furnished with four DSPs and consequently supports up to 120 voice

channels.

Number of simultaneous HG35xx channels
Voice-only 120
Table 8 Number of simultaneous Channels

In case of mixed Voice/T.38 fax operation, a maximum of 16 T.38 fax channels
per HG35xx can be used for the HiPath 4000 V3.0 and for the HiPath 4000 V4.0.
Up to 60 T.38 fax channels are supported per STMI for HiPath 4000 V6 R2.14.1
(HF003111) and higher independent of the STMI version. This applies as well for
OpenScape 4000 V7. The number of channels available for Voice is reduced by
the number of channels used for T.38 Fax. Please note the increased minimum
hardware-requirements for using T.38 Fax on more than two parallel lines (see
Section 2.4.1, “Server”, on page 35).

Connection scenarios from the XPR V7 view

The following table shows the maximum possible number of channels:

Number of XPR Number of | Channels voice-only

PCs HGs

Kernel | Satellites In total Kernels | Satellites
s

1 0 1 30 30 0

1 1 1 90 30 60
1 2 2 150 30 120
1 3 2 210 30 180
1 3 3 210 30 180
1 4 3 or more 270 30 240
1 5 3 or more 300 30 270
Table 9 Number of Channels for incoming Calls
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Number of XPR Number of | Channels voice-only
PCs HGs

Kernel | Satellites In total Kernel | Satellites
s s

1 0 1 30 30 0

1 1 1 90 30 60
1 2 2 150 30 120
1 3 2 210 30 180
1 3 3 210 30 180
1 4 3 or more 270 30 240
1 5 3 or more 300 30 270
Table 10 Number of Channels for outgoing Calls

2.4.4.5 Connecting a HiPath 4000 V6 and OpenScape 4000 V7
via SIP

In case of connecting the HiPath 4000 V6 oder OpenScape 4000 V7 via SIP the
following number of voice channels is available:

Codec | Maximum number of channels

Standard server' 2 Virtual Machine' V4 or V5
G.711 150 80
G.729 100 -

1 For example one computer with two processors with four cores for each processor with 2,53 GHz,
12 GB RAM and 64 bit

2 The following values apply for older systems such as a Xeon computer with 3.6 GHz and 4 GB
RAM: ISDN: G.711: 100 channels and G.729: 80 channels

Table 11 Maximum number of channels to a satellite computer

An even higher number of channels may be provided after a project-specific
release. The entire maximum is 300 channels.

IMPORTANT: The table gives values for sample configurations. Use the load
and dimensioning tool for more detailed values.
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2.4.4.6 Connection to a HiPath 8000/OpenScape Voice via SIP

In case of connecting the HiPath 8000/OpenScape Voice via SIP the following
number of voice channels is available:

Codec | Maximum number of channels

Standard server! 2 Virtual Machine' V4 or V5
G.711 150 80
G.729 100 -

1 For example one computer with two processors with four cores for each processor with 2,53 GHz,
12 GB RAM and 64 bit

2 The following values apply for older systems such as a Xeon computer with 3.6 GHz and 4 GB
RAM: ISDN: G.711: 100 channels and G.729: 80 channels

Table 12 Maximum number of channels to a satellite computer

An even higher number of channels may be provided after a project-specific
release. The entire maximum is 300 channels.

IMPORTANT: The table gives values for sample configurations. Use the load
and dimensioning tool for more detailed values.

Restrictions on connecting HiPath 8000 up to and including V3.0

An XPR server can only be connected to a HiPath 8000 up to and including
version 3.0 as preregistered terminal device with several channels (BGL,
Business Group Line), since connecting from voice mail may not be supported by
HiPath 8000 in case of a connection via a trunk (EP, End Point).

This results in restrictions especially if satellites servers are used, since the
HiPath 8000 V3.0 does not provide some features for preregistered terminal
devices, such as call distribution, failover, Transport Layer Security (TLS) and
arbitrary originator phone numbers.

Therefore, the satellites may not have the same access phone numbers. Each
satellite requires an individual access phone number. Without further measures,
only a computer with connection to the HiPath 8000 is possible.

Workaround

This problem can be evaded by assigning different Phonemail access phone
numbers to different user groups. For example, you can assign access phone
number 101, which represents the first satellite, to user group 1 and phone
access number 102, which represents the second satellite to user group 2 etc.
This means that a user of user group 1 must dial 101 as access phone number
for Phonemail, whereas a user of user group 2 must dial the phone number 102
as access phone number for Phonemail. If 40 users of group 1 had access to
Phonemail at the same time by dialing phone number 101, all channels of the first
satellite would be occupied. A 41st user of user group 1 would then not be able
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to access Phonemail by dialing phone number 101, even if all channels of the
second satellite were available. When the first satellite is not operable, no user
can access Phonemail by dialing 101. With this solution, up to 300 SIP channels
with G.711 or G.729 are supported.

Connection to an OpenScape Voice V3.1 and later via SIP

The OpenScape Voice V3.1 and later via SIP provides call forwarding via a trunk
(EP). Satellites are connected as trunks. All satellites have the same access
phone numbers. OpenScape Voice distributes incoming calls among different
satellites automatically. All users may use the same access phone number. A
user may access Phonemail as long as at least one channel is vacant on one of
the satellites.

The OpenScape Voice V3.1 and later recognizes a satellite as being not
operable. In this case it routes incoming calls to other satellites.

SRTP is available for communication with optiPoint and OpenStage telephones
as well as with RG gateways.

OpenScape Xpressions can set the phone number of an outgoing call to the
phone number of the user who has initiated the call. This enables correct call
charging for any terminal device.
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2.4.5 Maximum Number of Cards and Channels

Single-node scenario

If OpenScape Xpressions is installed on a single computer (single-node
scenario), a maximum of 2 S, interfaces can be installed.

If Sg boards are used, a maximum of 5 cards can be installed. If the largest BRI
cards (4BRI-8M) are used, 40 channels are available. In the event that more than
40 channels are to be available, PRI cards must be used. A maximum of 60
channels are supported.

Connection type | Maximum number of channels
Standard Virtual Machine?
server! va V5

ISDN 120 ¢

Cornet IP (G.711) |60 20 60

SIP (G.711) 120 20 120

SIP (G.729) 100 3 100

1 For example one computer with two processors with four cores for each
processor with 2,53 GHz, 12 GB RAM and 64 bit
The following values apply for older systems such as a Xeon computer with
3.6 GHz and 4 GB RAM: ISDN: 60 channels, Cornet-IP (G.711): 30 channels,
SIP (G.711): 60 channels and SIP (G.729): 60 channels

2 The virtual computer must have at least two cores and 4 GB RAM.

3 Because of its poor quality, G.729 is not released for VMware ESXi V4.

Table 13 Maximum number of channels for the single-node scenario

IMPORTANT: The table gives values for sample configurations. Use the load
and dimensioning tool for more detailed values.
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Kernel-satellite scenario

NOTE: The maximum number of channels with a connection via ISDN can be
achieved via different configurations. For example, 120 channels can be realized
by using a 4PRI card with 120 channels or via 4 PRI cards with 30 channels each.

If you use the largest BRI boards (4BRI-8M) on the kernel computer, 40 channels
are available. In the event that more than 40 channels are to be available, PRI
cards must be used. A maximum of 60 channels are supported.

If you use the largest BRI cards (4BRI-8M) on a satellite computer, 40 channels
are available. In the event that more than 40 channels are to be available, PRI
cards must be used. A maximum of 120 channels are supported.

Connection | Maximum number of channels
e Standard server! as kernel VMware ESXi? as kernel
V4 V5
In total Kernels | Per satellite | In total Kernels | Per In total Kernels | Per
satellite satellite

ISDN 300 120 120 8
Cornet IP 300 60 60 3008 0 60 3002 60 60
(G.711)
SIP (G.711) |300 100 150 300° 0 80 300° 100 150
SIP (G.729) |300 100 100 4 4 4 300° 100 100

1 For example one computer with two processors with four cores for each processor with 2,53 GHz, 12 GB RAM and 64 bit
The following values apply for an older kernel computer such as a Xeon computer with 3.6 GHz and 4 GB RAM:
- In total: ISDN: 300 channels, CorNet-IP (G.711): 300 channels, SIP (G.711): 300 channels, SIP (G.729): 300 channels
- Kernel: ISDN: 60 channels, Cornet-IP (G.711): 30 channels, SIP (G.711): 60 channels, SIP (G.729): 60 channels
- Per satellite: ISDN: 120 channels, Cornet-IP (G.711): 60 channels, SIP (G.711): 100 channels, SIP (G.729): 80 channels
2 The virtual computer must have at least two cores and 4 GB RAM.
If required, distribute the load among several VMware-ESXi-entities.
4 Because of its poor quality, G.729 is not released for VMware ESXi V4.

w

Table 14 Maximum number of channels for the kernel-satellite scenario

IMPORTANT: The table gives values for sample configurations. Use the load
and dimensioning tool for more detailed values.

A31003-S2370-S100-64-7620, 10/2025
52 OpenScape Xpressions V7 Release Notice, Service Documentation



Scope of Release
Hardware Requirements

2.4.6 Extension Restrictions on Conferences and
OpenScape WebClient

The following extension restrictions apply:
* Voice conferences

e Maximum 200 channels
Each single conference may entertain a maximum of 100 subscribers.

The voice channels for voice conferences are to be considered
independently from voice channels for Unified Messaging. In particular,
they are not counted among the systemwide restriction of 300 voice
channels for Unified Messaging.

IMPORTANT: A voice conference scheduled with n participants requires
n+2 licenses because there are always two additional stand-by channels
for unexpected participants.

e Connection to the PBX

* §porS, connection: HiPath 3000 V5, V6 and V7 and HiPath 4000 V3
and V4 cannot be connected via the program SIPControl by
Sangoma Diva because SIPControl is not supported anymore by
Sangoma Diva.

* |P/SIP connection: All other PBXs listed in the subsection Connection
options for new customers in Section 2.1, “PBX Connection Options”,
on page 17 are connected via an SIP trunk. Among such PBXs you
find e. g. HiPath 3000 V8 and V9, HiPath 4000 V5, HiPath 4000 V6,
OpenScape 4000 V7, R8300 (project-specific), HiPath 5000 (project-
specific) and OpenScape Voice. R8300 is a HiPath 4000 with a
reduced scope of service.

¢ Please consider the increased hardware requirements (see Section
2.4.1, “Server”, on page 35).

e \Web conferences

e Maximum 200 channels, i. e. any number of conferences with a maximum
total of 200 conference participants

¢ Each single conference may entertain a maximum of 100 subscribers.

* Please consider the increased hardware requirements (see Section
2.4.1, “Server”, on page 35).

* OpenScape Web Client

e Maximum 2500 users
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In case of a higher number of users a project-specific release must be
requested
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The following languages are supported:

Scope of Release

Languages

Language

Communications
optiClient 130
Web Client
Notes Extensions

Outlook Extensions
Web Assistant

IPPAssistant

XPR

Application Builder

German

/

English

v

French

Spanish

Italian

Dutch

Portuguese

Brazilian

SKKKNKKKK

Turkish

Russian

ANANANCNLNAN NLNENEN

Catalan

SKKKNKRKKNRKRKKRK

Table 15

Supported languages with GUI applications

Language

PhoneMail

Conferences VMS

Evo
Caller Guide

Text-to-speech

German

English (US)

(
English (UK)

French (France)

ANANANLN

(
French (Canada)

Spanish

Spanish (US)

Italian

Dutch

Portuguese

AN

Brazilian

Turkish

Russian

SKRKKNKKKNRKKNRKK

SKRKKNKKKNRKKNRKK

N KKNKKKNRKKKRKK

Slovenian

SNKKKNKKKNRKKNRKKA

Catalan

~

Table 16

Supported languages with TUI and SUI applications

Please note that, except for Catalan, the languages supported for PhoneMail are
identical with the languages supported for conferences.
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2.6 Released Software

NOTE: The version numbers specified here can be increased within the scope
of bug fixing (hotfixes). Updated OpenScape Xpressions software components
are available in the G-DMS respectively PRISMA.

2.6.1 Included in the Scope of Delivery

56

OpenScape Xpressions V7

Please obtain the build number from the release notes on the OpenScape
Xpressions setup medium.

Sangoma drivers of version 8.5.10 with support for CorNet-N/NQ/T

IMPORTANT: Sangoma ISDN PRI boards with the hardware version 1.0 and
2.0 are no longer supported by the Sangoma drivers of version 8.5.10 used
with XPR.

Voice prompts on the OpenScape Xpressions setup medium (in the
respective language packets)

HiPath license management
Nuance Vocalizer for Networks 5
Nuance Recognizer 9

Adobe Acrobat Reader 9

Microsoft SQL Server 2005 Express
PostgreSQL database

CAP Inside

Crystal Report Runtime Engine
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2.6.2 Not included in the Scope of Delivery

2.6.2.1 Server

Operating systems for XPR Server

Language |Operating system Release Service |Bit- Edition Released
pack width

Real

English! | Windows Server 202523456 | R0 - 64 Standard
English’ | Windows Server 202223456 | R0 - 64 Datacenter

German'/ | Windows Server 201923456 |Rg - 64 Standard
English’

Datacenter
Windows Server 201623456 |RQ - 64 Standard

Datacenter

Windows Server 201223456 RO and R2 64 Datacenter

Standard

Standard for
Embedded
Systems -
Telecommu-
nications

Windows Server 20087 R24 SP1 64 Datacenter
Enterprise
Standard

SKRKKNKRKNKRKK
SN N NN

ENANANLN
ENANANLN

for
Embedded
Systems -
Telecommu-
nications

Windows Cluster based on R2 - 64 Datacenter
Windows Server 20122356
Standard for

Embedded
Systems -
Telecommu-
nications

Windows Cluster based on R2 SP1 64 Datacenter
Windows Server 20087

NN
NN

Enterprise

ANANEN
ANANEN

for
Embedded
Systems -
Telecommu-
nications

Table 17 Released operating systems for the XPR server on real and virtual computers
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Language |Operating system Release Service |Bit- Edition Released

pack |width Real Virtual
German'/ | Windows 7 - - 64 Professional ‘/ with 8
English’ restrictions®

32 % %

Table 17 Released operating systems for the XPR server on real and virtual computers

1

w
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UEFI (Unified Extensible Firmware Interface) is not supported for any operating system. Use a BIOS instead. If you use hardware that
supports UEFI, check that the Legacy Only Flag is in top position of the boot sequence.

Only the Desktop Mode is supported. The Modern Ul Mode (Metro Mode) is not supported.

Only NTFS is supported as file system. ReFS (Resilient File System) is not supported.

IMPORTANT: TTS and ASR are only released on this operating system and for the case that one of the following conditions has been
fulfilled:

- Use of real hardware or

- Use of VMware ESX V4.0 or

- Use of VMware ESXi V5.0, V5.1 or V5.5

IMPORTANT: You need to select an installation version while setting up Windows Server 2012, Windows Server 2016 or Windows Server
2019, Windows Server 2022, Windows Server 2025. Only the Server with a GUI setup version is supported. The installation version
Server Core Installation (no .NET framework, reduced GUI etc.) is not supported

If you use Windows Server 2012, Windows Server 2016 or Windows Server 2019, Windows Server 2022, Windows Server 2025. NET
Framework 4 has been installed per default. Download .NET Framework 3.5 from the internet and install it additionally.

IMPORTANT: You need to select an installation version while setting up Windows Server 2008. Only the installation version Full
Installation is supported. The installation version Server Core Installation (no .NET framework, reduced GUI etc.) is not supported.
IMPORTANT: The following releases apply for operating OpenScape Xpressions on Windows 7 Professional :

- Up to 8 channels

- Up to 200 users

- SMTP and IMAP4

- Web Assistant (WebApl)

- ISDN hardware via ISDN APL (CAPI)

- Unified Messaging for Voice, Fax and Mail

- PhoneMail Telephone User Interface (TUI)

-VMS TUI

- ERGO Telephone User Interface (TUI)

- Connection to Microsoft Exchange

- No satellite systems or clusters

- No connection to groupware such IBM Notes/Lotus Notes or SAP

- No conference server.
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VMWare

Using OpenScape Xpressions V7 in a virtual environment based on VMware is
released for the following versions:

*  VMWare

*  VMware ESX V4.0

*  VMware ESX V4.1

*  VMware ESXi V4.0

*  VMware ESXi V4.1

*  VMware ESXi V5.0

*  VMware ESXi V5.1

*  VMware ESXi V5.5

*  VMWare ESXi V6.0

*  VMWare ESXi V6.5

*  VMWare ESXi V6.7

*  VMWare ESXi V7.0

*  VMWare ESXi V8.0
VMware ESXi is also called VMware vSphere Hypervisor.
*  Proxmox KVM VE 8.3.1

* Microsoft Hyper-V

IMPORTANT: Not all versions have been released for TTS and ASR (see footer
4in Table 17 on page 57).

A31003-S2370-S100-64-7620, 10/2025
OpenScape Xpressions V7 Release Notice, Service Documentation 59



Scope of Release
Released Software

The following configuration parameters apply:

Property Minimum Number of XPR users
hardware  f34q 1000 3000 5000 10000 15000
Server XPR (Voice Only System)
Scenario Single-node scenario ‘ Kernel-satellite scenario

Number of kernel
computers

1

Number of satellite
computers (minimum)

0

Number of supported
channels

See Table 13 on page 51, “Maximum number of channels for the

single-node scenario”

See Table 14 on page 52,
“Maximum number of
channels for the kernel-
satellite scenario”

Configuration parameters of the virtual computer

Size of the virtual disk | 80 80 85 220 360 Kernel: 690, | Kernel:

in GB2 each 1030,
satellite: 80 |each

satellite: 80

Number of virtual 1 15 15 2° 35 Kernel: 2°, |Kernel: 3,

CPUs (minimum)?3 4 per satellite: | per satellite:
25 25

Memory size in GB 3 3 3 3 3 Kernel: 3, Kernel: 4,

(minimum)6 per satellite: | per satellite:
2 2

Further parameters.

Additionally required |0

disk space ’ in GB

Hard disk throughput | Unavailable |260 800 1250 2200 3900 5100

in kB/s

Network bandwidth in | Unavailable | 1300 3000 6400 12000 86000 160000

kbit/s

Table 18

Parameter Capacity

Virtual Machine configuration parameters
1 XPR on Virtual Machine for 15000 users needs a project-specific release.

2
3 Changing the number of virtual CPUs after the operating system is installed is not supported.
4 With VMware ESXi 4.1 the parameter is called Number of virtual processors and with VMware ESXi V5.1 it is called Total number of

cores.

(¢,

Xeon X7560 with 2.27 GHz

6 The number of possible guest operating systems in which an XPR server may be installed and operated depends to a great extent on the
performance of the host system. Please note that the real load generated in real operation is hard to estimate in advance and depends on
many factors. Therefore, we recommend copious load tests before a host system starts real operation and to increase the RAM if needed.

7 Disk space on the computer or SAN for e. g. images, patch sets, restore CDs etc.

60

You find additional configuration parameters in the section “XPR in a virtual
Environment” in the installation guide OpenScape Xpressions Server Installation.
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Support of VMware features or products
The following VMware features or products are supported:

1. VMware High Availability

IMPORTANT: In case of damaged hardware there is only little risk of the
system not being restorable because of a damaged file system. This risk is
unspecific for the OpenScape UC Application. It concerns every virtual
computer protected by VMware High Availability.

2. VMware vMotion

VMware vMotion is a tool for migrating a running virtual computer from one
host computer to another host computer. This tool has been released with the
following restrictions:

a) Time of the migration

IMPORTANT: Use VMware vMotion only at times of low system load. Do
not use VMware vMotion during business hours!

b) No CPU core must be permanently assigned to a virtual computer during
the migration. If you use permanently assigned CPU cores, cancel this
assignment before the migration and reassign the cores after the
migration. You can do this while the virtual computer operates.

c) Each fax being transmitted at the time of a migration will be damaged or
abandoned. This effect is stronger for G.711 than for T.38.

d) Callers hear during the migration a short cracking noise at the most or are
shortly interrupted. The phone call will not be terminated.

e) Now and then and for a short moment (1 s - 2 s) you will not receive a
response when operating the clients (CSTA and MSP) but things will be
all right again after the migration.

f) If the kernel computer or a satellite computer is migrated in a distributed
system, the connection may become shortly interrupted. If the satellite
computer receives a message to be transported to the message store of
the kernel computer in this moment, the message gets lost and an error
message is generated.

3. VMware vSphere Data Protection 5.1 (VDP) and VMware Data Recovery
(VDR)

NOTE: See point 7 on page 63 for further data backup and restore options.
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VVDP operates on VMware ESXi V5.x. VDR operates on VMware ESXi V4.x.

When backing up a virtual machine with VMware vSphere Data Protection 5.1
on Windows 2008 R2, the di sk .EnableUUID parameter must be previously
set to false in the settings of the virtual computer.See also VMware-
Knowledge-Base-Artikel 2035736:

http://kb.vmware.com/selfservice/microsites/
search.do?language=en US&cmd=displayKC&externalId=2035736

The following VMware features or products are NOT supported:
1. VMware Distributed Resource Scheduler (DRS)

2. VMware Fault Tolerance
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The following applies:
1. XPR on Virtual Machine is released in local company networks only.

2. Verify that the host systems, storage systems and networks used provide the
required resources and response times.

Please note the following:

a) Be sure to exclusively use the features supported by Virtual Machine
solution provider.

b) Heed the warnings in the Virtual Machine documentation.

For example, changing the number of CPU cores after the XPR
installation is not permitted.

c) Follow the instructions in the Virtual Machine documentation for enabling
a solution that comes close to a real-time system as far as possible.

d) Configure the virtual computer according to Table 18 on page 60, “Virtual
Machine configuration parameters”. Reserve in particular the CPU and
memory resources according to this table.

3. The following scenario is supported also: The XPR server (kernel) is installed
on a virtual computer with the Virtual Machine software released above. One
or several satellite computer(s) is/are connected to this XPR server. Such
satellite computers can be virtual computers with the Virtual Machine
software released above or real computers. If they are real computers, you
can use Sangoma ISDN boards in them (see Section 2.4.1, “Server”, on page
35).

4. |If you use real computers for the XPR server, a maximum of 15000 users is
supported. If more users are to be supported, a project-specific release (PSR)
must be applied for.

When using the load and dimensioning tool (see Chapter 1, “General
Considerations”) you need to set in the tool that the values for a virtual
environment shall be calculated.

5. In such a scenario, the hardware requirements of the host system and of all
guest systems must be added. This applies in particular for RAM and hard
disk capacity.

6. Furthermore, such a scenario merely allows an IP-based connection. Please
heed for your dimensioning the hard and software requirements mentioned in
the OpenScape Xpressions Server Installation instructions for operating
OpenScape Xpressions V7. Please also note the hard and software
requirements of the virtualization software. There will be no support if
problems occur that origin from scenario-specific conditions and that cannot
be uniquely assigned to the OpenScape Xpressions V7 product.

7. Data backup and restore
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Data backup and restore is supported on virtual computers with Windows
Server 2008 R2 by the following means:

a)

Microsoft Windows Server Backup Features

Open Start > All Programs > Administrative Tools > Server
Manager > Features > Add features > Windows Server Backup
Features to initiate the installation of the server backup features. You can
then start them under Start > All Programs > Administrative Tools >
Windows Server Backup.

Veeam Backup & Replication 6.1
VMware vSphere Data Protection 5.1 (VDP)
VMware Data Recovery (VDR)

See point 3 on page 61 for details.

Miscellaneous
* Microsoft Exchange Server 2003 with SP2, 2007 and 2010

¢ PCAnywhere version 12 + SP (software for remote maintenance)

e Connector components for IBM Domino integration / Lotus Domino
integration

Lotus Notes/Domino R 6.0 German/English

Lotus Notes/Domino R 6.5.1, 6.5.3 or 6.5.4 German/English

Lotus Notes/Domino R7 versions 7.0.0, 7.0.1, 7.0.2 German/English
Lotus Notes/Domino R8 versions 8.0.x and 8.5.0 to 8.5.3 German/English

The Lotus Notes Basic Configuration client is supported as connector
component of the Lotus Domino integration but not the Lotus Notes
Standard Configuration client.

IBM Notes 9.0 Social Edition (Basic Configuration) and IBM Domino 9.0
Social Edition German/English

NOTE: The names of versions lower than IBM Notes 9 and IBM Domino
9 are Lotus Notes and Lotus Domino.

NOTE: Ifyou use IBM Notes 9.0 Social Edition (Basic Configuration) and
IBM Domino 9.0 Social Edition, use the mail templates for Lotus Notes 8.

e Antivirus programs
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This virus detector is released for operation parallel to the XPR server
only.

XPR was tested with TrendMicro Office Scan successfully. If problems
occur with other anti-virus software it may have to be disabled or
uninstalled.

NOTE: When you perform a real-time scan, you need to exclude the
directories <install>\Backup, <install>\Folders and
<install>\Infostor from the scan to avoid access errors.
<install> is typically C:\OpenScape\xpr.

AV4UC (Trend Micro)

The following products of the AV4UC (Trend Micro) product family have
been released:

e Server Protect for Windows (SPNT) V5.58
* Control Manager Advanced (CMA) V5.5
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2.6.2.2 Clients

NOTE: All client programs except for optiClient 130 with HFA (HiPath Feature
Access) can also be executed on 64-bit operating systems. However, they are not
compiled in the 64-bit mode.

The following programs have been released for the clients:

UEFI (Unified Extensible Firmware Interface) is not supported for any operating
system. Use a BIOS instead. If you use hardware that supports UEFI, check that
the Legacy Only Flag is in top position of the boot sequence.
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Microsoft Windows 7 Professional Edition
Microsoft Windows 7 Ultimate Edition
Microsoft Windows 7 Enterprise Edition
Microsoft Windows 8.1 Pro Edition
Microsoft Windows 10 Pro

Restrictions:

e Only the Desktop Mode is supported. The Modern Ul Mode (Metro
Mode) is not supported.

* UEFI (Unified Extensible Firmware Interface) is not supported. Use a
BIOS instead.

Client programs for application conversions

The MTA can convert specific application formats into a fax format by
invoking an associated application. With the following programs application
converters are available for the formats:

— Microsoft Office 2016/2019/2021//2024/365 Apps
¢ Microsoft Word: doc, rtf, htm
¢ Microsoft Excel: xlIs

e Microsoft PowerPoint: ppt, pps

Microsoft Office 2010/2013/2016/2019 can be used for the application
conversion in the 64-bit version also.

— Foxit Reader:pdf

Other application conversions are not approved, but you can use them
project-specifically without producer support.
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* Exchange clients

Microsoft Outlook 2007

Microsoft Outlook 2010

— Microsoft Outlook 2013

— Microsoft Outlook 2016

— Microsoft Outlook 2019

— Microsoft Outlook 2021

— Microsoft Outlook 2024 Classic
Microsoft Outlook 365 Classic

¢ |BM Notes / Lotus Notes

NOTE: The names of versions lower than IBM Notes 9 are Lotus Notes.

* Lotus Notes 6.5.1,6.5.3 0or6.5.4

e Lotus Notes 7.0.0 and 7.0.1, 7.0.2

¢ Lotus Notes 8.0.x and 8.5.0 up t0 8.5.3

e IBM Notes 9.0 Social Edition (Basic Configuration)

NOTE: If you use IBM Notes 9.0 Social Edition (Basic Configuration),
use the mail templates for Lotus Notes 8.

* SAP R/3 from version 4.5b
* IMAP clients
— Microsoft Outlook 2007
— Microsoft Outlook 2010

NOTE: All these Outlook versions are released as OpenScape Xpres-
sions IMAP client only on client PCs on which Outlook is not already
operated as Exchange client.
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Internet browser

For the WebClient
e Internet Explorer 7. 0, 8.0, 9, 10 and 11

NOTE: If you use Internet Explorer 10, make sure that the compatibility
view is not used for the intranet, executing the following steps:
In the menu bar open Tools > Compatibility View settings... and clear
the Display intranet sites in Compatibility View check box.

NOTE: If you use Internet Explorer 11, make sure that the compatibility
view is used for the intranet executing the following steps:

In the menu bar open Tools > Compatibility View settings... and check
the Display intranet sites in Compatibility View check box.

* Firefox 2.0 up to 3.6

NOTE: The web browsers versions support for the XPR WebClient will
not be updated anymore.

For the WebAssistant

* Internet Explorer 7. 0, 8.0, 9, 10 and 11

NOTE: If you use Internet Explorer 10 or newer, make sure that the
compatibility view is not used for the intranet executing the following
steps:

In the menu bar open Tools > Compatibility View settings... and clear
the Display intranet sites in Compatibility View check box.

¢ Firefox 59.0
e Safari5.1.7
e Chrome 66.0

NOTE: If the Firefox setting enables saving passwords, a dialog to confirm
the password opens each time a user with administrator privileges accesses
the configuration page of a user.
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2.7 Documentation

Part number
A31003-S2370-S100-*-20
A31003-S2370-S101-*-20

A31003-S2370-Y100-*-7618

A31003-S2370-J100-*-31
A31003-S2370-J101-*-31
A31003-S2370-J102-*-31
A31003-S2370-J103-*-31
A31003-S2370-J105-*-31
A31003-S2370-J106-*-31
A31003-S2370-M100-*A9
A31003-S2370-M101-*A9
A31003-S2370-M102-*A9
A31003-S2370-M103-*A9
A31003-S2370-M104-*A9
A31003-S2370-M105-*A9
A31003-S2370-M106-*A9

A31003-S2360-U100-*-7619

A31003-S2370-U101-*-19
A31003-S2370-U122-*-19
A31003-S2370-U102-*-19
A31003-S2370-U123-*-19
A31003-52370-U103-*-19
A31003-S2370-U104-*-19
A31003-S2370-U124-*-19
A31003-S2370-U125-*-19
A31003-S2370-U105-*-19
A31003-S2370-U106-*-19
A31003-S2370-U107-*-19
A31003-S2370-U108-*-19
A31003-S2370-U109-*-19

A31003-S2370-U126-*-7619

A31003-S2370-U110-*-19
A31003-S2370-U111-*-19
A31003-S2370-U112-*-19

Documentation type

Service documentation

Service documentation

Description

Installation guide

Installation guide

Installation guide

Installation guide

Installation guide

Installation guide

Administrator documentation

Installation and administrator documentation
Installation and administrator documentation
Installation and administrator documentation
Administrator documentation

Installation and administrator documentation
Administrator documentation

User guide

User guide

Short user guide

User guide

Short user guide

User guide

User guide

Short user guide

Short user guide

User guide

User guide

Short user guide

Short user guide

Short user guide

Short user guide

User guide
Short user guide
Short user guide

A31003-S2370-S100-64-7620, 10/2025
OpenScape Xpressions V7 Release Notice, Service Documentation

Scope of Release
Documentation

Title

Release Notice

Security checklist

System Description

Server Installation

Cluster Installation

Upgrade Instructions

Client Installations

Cisco UC Manager
optiClient 130 & MS Dynamics CRM
Server Administration
Microsoft Exchange Gateway
IBM Notes Gateway

SAP R/3 Gateway

Multi Tenancy

Multimedia Contact Center
optiClient 130 Administration
Client Applications

Web Assistant

Web Assistant

Microsoft Outlook Extensions
Outlook Extensions

IBM Notes Extensions
optiClient 130

optiClient 130

optiClient 130 - ACD Agent
OpenScape Web Client
PhoneMail

PhoneMail User Card
PhoneMail Function Tree

PhoneMail Function Tree
Simplified mode

PhoneMail Function Tree
Octel-like-Menu (in English only)

VMS
VMS User Card
VMS Function Tree
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A31003-S2370-U113-*-19
A31003-S2370-U114-*-19
A31003-S2370-U115-*-19
A31003-S2370-U116-*-19
A31003-S2370-U117-*-19
A31003-S2370-U118-*-19
A31003-S2370-U119-*-19
A31003-S2370-U120-*-19

User guide
User guide
Short user guide
Short user guide
Short user guide
User guide
User guide

User guide

2.8 General Information

EVO

ERGO

ERGO

ERGO Function Tree
Conferencing
Communications
Application Builder

IP-Phone Assistant

Further XPR V7 platform features listed neither in the sales information nor under
the project-specific releases are generally not available with OpenScape

Xpressions V7.

2.9 Product Validation and Quality Approval Procedure
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The OpenScape Xpressions test results are recorded in a specific test report.
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Restrictions
General Restrictions

3.1 General Restrictions

1.
2.

10.
1.

12.

The XPR server must not be installed on the domain controller.

Connecting a HiPath 3000 via the CorNet-NQ protocol to OpenScape
Xpressions V7 is not released.

Fax-on-demand is only permitted by the server in fax-polling mode. FOD
services executed via the voice menu are not released.

Fax-On-Demand is only supported with connection via ISDN APL.

Access via OpenScape Xpressions Communications to TUM mailboxes is not
possible for foreign message stores.

Access numbers starting with "0" are not possible.

As of XPR V7 RO, only Nuance Vocalizer for Networks is used for text-to-
speech.

If more than three Sangoma-4BRI boards are used in combination with
CorNet-T, the connection can be bad in case of call forwardings. As
workaround a new key of type REG_MULTI_SZ must be defined under the
name Private and set to value TransfervViaDeflect=1 in the registry
under

HKLM\ SOFTWARE\PP-COM\MRS\ IsdnApl\Devices\XX
(with XX representing the devices)

for each device (one 4BRI module provides 4 devices).

OpenScape Xpressions supports up to 60 APLs plus kernel services (MTA,
InfoStor, XMRSvc, NameLoc, CfgSvc, mrs).

The maximum number of users is restricted to 5000 per ExXUmAPL.

The following Application Protocol Layers (APLs) are not supported any
more:

o WE2XT
e XA2HT

e HLBFAX
* LDAPs

e HXCSvc

When using a HiPath 8000 or OpenScape Voice, display texts for the TUl are
not supported.
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13. The HiPath Xpressions Extensions (HXE) are released neither for a new
installation nor for an update.

14. Using the OfficeScanNT personal firewall is not supported on a OpenScape
Xpressions server, since otherwise the connection between the CLC and the
CLA would be disturbed and the OpenScape Xpressions server functionality
could not be guaranteed.

15. The Microsoft SQL Server Desktop Engine (MSDE) has been replaced with
SQL Server 2005 Express, because Microsoft does not support MSDE any
more.

16. optiClient 130 can be operated in a combined connection, i.e. it can be
connected to an XPR server as well as to an SIP communication system as
SIP telephone in parallel In this combined connection it can solely use the
following XPR services:

e ACD features
e Call journal
¢ Presence feature

* Server directory

In the combined connection, optiClient 130 can especially not be used as CTI
client to monitor and control a desk telephone.

17. The following components are approved for operation on terminal servers:

Client Component Microsoft Citrix MetaFrame XP
2003/2008 Terminal
Server

optiClient 130 Yes’ Yes

Outlook message forms | Yes Yes

MAPI fax printer drivers | No Yes

* The support of optiClient 130 in Microsoft terminal server environments respectively
Citrix MetaFrame environments is restricted to the use of CTl features. Usage as IP
client (SIP softphone) is not possible here.
The OpenScape Xpressions Communications Client and the Notes Client are
not released for terminal server operation.

18. optiClient 130 cannot be used as SIP telephone on Windows Vista.

19. If optiClient 130 is to communicate as SIP softphone via a VPN connection,
the QoS packet planner must not be installed under the Windows operating
system.

20. An optiClient 130 of product type Xpressions must not be installed on a
computer on which an optiClient 130 different from the Xpressions product
type has been set up. The same applies vice versa also.
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22.

23.
24.

25.

26.

27.

Restrictions
General Restrictions

The Microsoft Outlook integration of optiClient 130 must not be used in
combination with the Microsoft-Outlook-Add-In CryptoEx Outlook Version
3.0.

The 64-bit version of Outlook is not supported by optiClient 130. This applies
not only for the CTI client optiClient 130 but also for the optiClient 130 plug-
in in Outlook (“Dial” button).

This button and other buttons in Outlook caused by the Outlook Extensions
(icon and message forms) are independent of each other.

CSV import with the Web Client is not supported for Outlook 2010.

The Caller Guide is only released for using names that do not contain any
digits.

Crystal Reports 2008 must not be installed on the computer that also hosts
Crystal Reports Developer Edition XI.

Direct Delivery of Incoming Messages via SMTP

If SMTP is entered in the PREFERRED field as the service so that incoming
messages are forwarded to another SMTP mail server directly via SMTP, the
OpenScape Xpressions data can no longer be accessed using IMAP4/POP3
clients or the telephone user interface. For this reason, this configuration is
not recommended.

The IP APL with CorNet-IP does not support the following features:
¢ Digit-by-digit dialing information transmission

If case of a digit-by-digit dialing information transmission the first call sign
received is already evaluated. If the dialing information is transmitted
block-by-block, a received phone number is not further processed until
the entire phone number is received. The PBX must be set to either block-
by-block or digit-by-digit dialing information transmission. In contrast, no
settings need to be made in the IP APL.

e Callback if busy (CCBS; Completion of Calls to Busy Subscriber)

A caller who receives a busy sign from his/her callee can request this
feature via his/her telephone's keypad before putting the phone down.
When the previously busy callee puts his/her phone down, the caller's
telephone is informed about this by a special ringtone. If the caller
answers this return call by picking up the receiver, the callee is called
again.

e Callback if no reply (CCNR; Completion of Calls on No Reply)

A caller whose call is not accepted can request this feature via his/her
telephone's keypad before putting the phone down. When the callee puts
the phone down the next time, the caller's telephone is informed about
this by a special ringtone. If the caller answers this return call by picking
up the receiver, he/she is reconnected to the desired callee.
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28.

20.

30.

31.

32.

33.

34.

¢ Hicom PIN

If you call the XPR server access number you need to enter a PIN for
logging on. The HiCom-PIN feature means that you only need to perform
this logon process once a day. In case of a second call you are logged on
without being prompted to enter a PIN.

* Remote activation of a call diversion

Remote activation of a call diversion means that you, for example, call the
access number of the XPR server TUI from your private phone to activate
a call diversion to your own business phone by TUI.

OpenScape Web Client requires a Java runtime environment of version 1.4
or later on the client computer to function correctly. Version 1.4.2.06 of the
Java runtime environment is not supported.

OpenScape Web Client must not be installed if the XPR is integrated with a
HiPath ComAssistant. In this case you may consider replacing the HiPath
ComAssistant with the OpenScape Web Client integrated in Xpressions.

The OpenScape Web Client was developed based on the HiPath
ComAssistant. Instead of directly accessing the PBX or via HiPath CAP,
every access made goes via the combination of CSTA APL and CTI APL.
Therefore, some specialities that the HiPath ComAssistant mastered with
specific PBXs are not possible here. In particular, only the settings listed in
the administrator documentation OpenScape Xpressions Server
Administration have been tested and released. You can test continuative
configuration options via a project-specific release.

You must not set up an XPR on a computer on which a HiPath ComAssistant
is installed. In this context it is irrelevant whether or not the XPR is to be
integrated in the HiPath ComAssistant.

No client program supports Citrix Application Isolation.

The name of the computer on which the XPR is installed must not exceed 15
characters.

No NAT may exist between the OpenStage telephones and the XPR server,
since this would prevent voicemail playback.

Setting up an XPR Connection APL on a satellite has not been released.

NOTE: Itcan be released project-specifically only if this satellite is connected
to an XPR kernel on a Windows cluster (see point 6 on page 80 for further
details and please also refer to point 4g on page 91).
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35. The Application Builder comprises ASR (Automatic Speech Recognition) and
ACD (Automatic Call Distribution) also. ASR is a component of the default
XPR product and can be licensed. However, ACD is not a component of the
default XPR product and requires a special license.

36. A T.38 fax is transmitted with a maximum of 35 kbit/s per channel. More
important than the transmission speed is the latency period, which must not
exceed 100 milliseconds.

37. The following requirements must be complied with for using the ERGO
Trusted Transfer Mode (TTM):

a) The XPR server and the OpenScape UC Application must be connected
to the same PBX.

b) The XPR server and the OpenScape Voice must be connected to each
other via SIP.

c) The Trusted Transfer Mode supports only a 1:1 relationship between an
ERGO entity and a voiceportal access number.

d) The start character in phone number format of the Trusted Transfer Mode
must not be removed from a PBX or a gateway between the XPR server
and the OpenScape UC Application.

38. The computer on which the VM2TXT APL runs must have a TCP connection
to the internet. If the VM2TXT APL is installed on a Windows cluster, both of
these cluster nodes must provide this internet connection. Please consider
that the customer may regard this as a security risk. If the computer on which
the XPR core components run are not connected to the internet but the
VM2TXT APL is required just the same, this APL must be installed on a
satellite computer.

The VM2TXT APL sends the voicemail contents to a computer by Nuance for
conversion into text. This too might be considered a security risk.
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39. The following features are not supported anymore:

40.

MMCC (Multimedia Contact Center)
o x-Kit

¢ TNG (The Next Generation)

* SAPbyDesign

These features must not be upgraded in the course of an upgrade to XPR V7.
They must be uninstalled.

All information about these features in other XPR V7 documentation is
obsolete.

SSL 2 and SSL 3 are no longer supported by the WebAPL. They were
replaced with TLS. Only the following ciphers are supported:

TLS_RSA_WITH_AES_128_CBC_SHA AES128-SHA
TLS_RSA_WITH_AES_256_CBC_SHA AES256-SHA

TLS_RSA WITH_3DES_EDE_CBC_SHA DES-CBC3-SHA

SSL_RSA WITH_3DES_EDE_CBC_SHA DES-CBC3-SHA
TLS_DHE_RSA_WITH_AES_128 CBC_SHA DHE-RSA-AES128-SHA
TLS_DHE_RSA_WITH_AES 256 _CBC_SHA DHE-RSA-AES256-SHA
TLS_DHE_RSA_WITH_3DES_EDE_CBC_SHA EDH-RSA-DES-CBC3-SHA
SSL_DHE_RSA_WITH_3DES_EDE_CBC_SHA EDH-RSA-DES-CBC3-SHA
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41

42,
43,
44,

NOTE: TLS V1.0 is identical with SSL V3.1.

IMPORTANT: Now TLS V1.2 is used by default.

. TTS and ASR are released only on a specific operating system and for the

case that one of the following conditions has been fulfilled:
- Use of a real hardware or

- Use of VMware ESX V4.0 or

- Use of VMware ESXi V5.0, V5.1 or V5.5

(see footer 4in Table 17 on page 57)

A PrintAPL supports a maximum of 150 printers.
IPv6 is not supported by XPR.

The following features are not supported anymore:
e Wall APL

e ACD Supervisor
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All information about these features in other XPR V7 documentation is
obsolete.

45. You cannot perform a phone number normalization depending on the
invoking user for MSPTSP applications.

MSPTSP is short for MSP TAPI Service Provider.

The MSPTSP is a TAPI Service Provider that translates TAPI commands in
CTl transactions of the XPR server. Communication occurs via the MSP as is
usual for the XPR server. However, there's the speciality that the MSPTSP
operates as TAPI service provider in the system context of the operating
system, thus being unable to deploy the MSP user profiles possibly
configured, because it is not privileged to access such data. In this respect,
an individual user profile valid for the computer on which the MSPTSP
operates must be configured for the MSPTSP. For this reason, logging on via
the Windows user account is not possible either.

See the operation guide OpenScape Xpressions Client Applications for
MSPTSP details.

46. Multi tenants
a) Voice guide (Vogue) support

If a user deploys the voice guide on an XPR server with several tenants,
only users of the same tenant are returned if a corresponding
configuration has been performed. Such settings are valid for an SIP
connection only.

b) The location and tenant settings of the XPR server can be configured with
help of the FI APL and a configuration file. To enable this, the
XprConfig.e configuration script, being able to process appropriate
configuration files, is shipped for the FI APL. Such settings are valid for
an SIP connection only.

47. Asilent upgrade does not need any user interaction. The following restrictions
apply to it.
a) Only XPR V6 R2 64-bit, XPR V7 RO 64-bit and XPR V7 R1 64-bit can be
upgraded silently to XPR V7 R1 FR1.

b) The silent upgrade does not change any feature, i. e. it corresponds to a
normal upgrade that has been initiated by the Repair radio button.

c) The silent upgrade of UCC components such as Web Collaboration
server, ConAPL, media server and conferencing module is not supported
on satellite computers.

d) XPR clients such as Communications or XPR Monitor must have been
terminated before the silent upgrade has been started.
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48.

49.

50.

51.
52.
53.

54.

55.

56.

You can configure in the OpenScape Web Client that incoming calls are
forwarded to another phone number if your office phone is engaged (on busy
to radio button) or if the specified ring time of the device is exceeded (after
time to radio button). These two features are not supported for a connection
to a HiPath 4000/OpenScape 4000 via SIP or for a connection to a HiPath
3000.

XPR on Virtual Machine is supported only for up to 10000 users. A project-
specific release is needed for more than 10000 users.

Internet Explorer 11 is supported by Xpressions WebClient only when running
in Compatibility View Mode.

NOTE: If you use Internet Explorer 11, make sure that the compatibility
view is used for the intranet executing the following steps:

In the menu bar open Tools > Compatibility View settings... and check
the Display intranet sites in Compatibility View check box.

DI-Tool is not supported with Internet Explorer 11.
Windows 8 Metro Interface is not supported.

The communications client does not support tenant features. The
WebAssistant is recommended to be used to work with tenant users.

Due to the Office 2007 End Of Life declared by Microsoft on October 10th,
2017, Xpressions Development team will no longer provide support for this
Microsoft Office version. (https://support.office.com/en-us/article/office-2007-
end-of-life-roadmap-416¢c54d8-823c-4def-bb7a-6a9b14ef2745).

Therefore, Outlook 2007 forms (SBF/SBFCC/LocalForms) and Office 2007
server conversion will not be supported anymore.

OpenScape Xpressions client 'Communications' must be used only for
Administrative purposes and must not be used as a mail client. WebAssistant
should be used in its place.

TLS V1.2 is used by default.

If for some reason TLS V1.1 or TLS V1.0 needs to be used for webapl, ipapl
or smtpapl, then the related DWORD registration keys can be enabled.
(SSL_TLSv1_Enable or SSL_TLSv1_1_Enable)
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57. Xpressions UCC components out of support

NOTE: Apache Tomcat server may have unfixed vulnerabilities that are
impacting OpenScape Xpressions. Apache Tomcat server is no longer
maintained by OpenScape Xpressions since it was part of UCC Components
that is out of support and OpenScape UC integration must be used on its
place.

For this reason, we strongly recommend to uninstall any UCC components
installed on OpenScape Xpressions server and if it is not possible, at least
block the access to ports 7789 and 8443 on OpenScape Xpressions server.

On July 2019 the Xpressions UCC components have reached the M5 status
and therefore they are out of support.

Affected components:

e Xpressions WebClient
¢ Conferencing

* Web Conference

e Cti Functionality

58. Xpressions components out of support

The following Xpressions components are out of support:
¢ Outlook/Notes Conference
¢ OptiClient

e Communications (as mail client)

e CtiApl

e CstaApl

e  MspTsp

¢ SapR3Apl

e SapRouteApl
¢ SapPhoneApl

e ABCApl

¢ LPRApI

*  V24APL

e Vm2TxtApl
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3.2 Project-Specific Release

IMPORTANT: Each feature not explicitly released in this release notice is not
released or requires a project-specific release (PSR). In the PSR process,
project-specific release may be granted or rejected for a feature. The process
may also result in a release notice modification to explicitly release a feature or
to explicitly deny the release.

Features that are released only project-specifically are not necessarily mentioned
in this release notice. Please read the respective setup and administration guides
or other instructions to see whether a feature has been released project-specifi-
cally. Example: the documentation for connecting the XPR to a Microsoft
Exchange server informs you about project-specific releases that exist to connect
the XPR to a Microsoft Exchange server. In Section 2.7, “Documentation”, on
page 69 you find a documentation list.

The following features have exclusively been released for project-specific usage:

1. From Section 3.11, “Restrictions on a Cluster Installation”, on page 88 you
can obtain which APLs may be installed on a Windows cluster without project-
specific release with general or limited availability.

SAP/R3 integration for SAP R/3 3.1, 4.6 and CRM 3.1
Message import from foreign POP3 servers
DSS1 connection

Numerous distributed systems with a single access number

o g M~ w0 DN

Setup of an XPR Connection APL on a satellite only under the condition that
this satellite is connected to an XPR kernel on a Windows cluster (see
Section 3.11, “Restrictions on a Cluster Installation”, on page 88). No further
XPR Connection APL may be installed on any other satellite. If UC
components (web conference server etc.) are to be installed, they may only
be set up on the satellite on which the XPR Connection APL is installed also.
See also point 34 on page 74 and point 4g on page 91.

7. The PostgreSQL database, a component of the Connection APL is needed
for the restore step in the feature Smart Backup and Restore. If an XPR
server is installed on a Windows cluster, the Connection APL can be installed
according to point 6 on page 80 only on a satelllite and only with a project-
specific release. That means that if an XPR server or MRS-Server on a
Windows cluster is upgraded to XPR V7 R1 by means of the Smart Backup
and Restore feature, a project-specific release is needed for XPR V7 R1.
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3.3 Restrictions on the IMAP4 Client

(see also Chapter 7, “Information for Users”)

1.
2.

IMAP directories cannot be administrated on the server.

The "Deleted Items" folder is not supported by the OpenScape Xpressions
server.

Outlook 2002/2003/2007/2010 as IMAP client of OpenScape Xpressions is
only released on client PCs on which Outlook is not already used as the
Exchange client.

Netscape: version 7.1 is released as IMAP client for OpenScape Xpressions.

Outlook Express version 5.5 and version 6 is released as the IMAP Client for
OpenScape Xpressions.

All other POP3/IMAP4 Clients and versions must be tested on a project-
specific basis.

The local forms for SMTP cannot be installed in a terminal server
environment.
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3.4 Exchange Integration Restrictions

82

(see also Chapter 6, “Information on Exchange Integration”)

1.

Mailbox replication (replication of all incoming Exchange messages of a user
to a corresponding mailbox in OpenScape Xpressions) is to be limited to a
maximum of 5000 Exchange users. This number has been successfully
tested in the lab, but no general release may be deducted from this. The
actually possible number of Exchange users depends on many different
factors of a scenario and may have to be determined in the course of project
supervision.

NOTE: Mailbox replication is not supported in case of connection to
Exchange Server 2007 and 2010.

Integrated Messaging users who are Exchange Server 2003 users cannot be
upgraded to Integrated Messaging users who are Exchange Server 2007 or
Exchange Server 2010 users. They must be converted into TUM users.

If mailbox replication is used by 200 Exchange users or more, it does not
immediately take effect after a message has come in, but after an interval of
5 minutes or more. We generally recommend to set an interval for activating
the mailbox replication.

To avoid problems owing to increased restrictions on MAPI sessions,
configurations are required on all connected Exchange mailbox servers.

IMPORTANT: You can obtain more information from the installation and
administration documentation OpenScape Xpressions Microsoft Exchange
Gateway.

For an integration in a Hosted Exchange 2007 see Section 6.1.7.6,
“Integration in Hosted Exchange 2007”, on page 109.

In a Microsoft Exchange environment, the use of public folders in combination
with optiClient 130 and Pubany is restricted to five public contact folders per
user. This restriction must be established by appropriate read permissions in
the Exchange configuration. In addition, each of these public contact folder
must not contain more than 1.000 entries.

If you wish to run the Exchange 2003 Connector on one of the following
operating systems, you cannot use the Exchange System Manager, because
it has not been released for 64-bit operating systems. Use Exchange
MAPICdo (see http://www.microsoft.com/en-us/download/
details.aspx?id=1004) instead.

*  Windows Server 2008 R2 Standard Edition (always 64-bit)
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*  Windows Server 2008 R2 Enterprise Edition (always 64-bit)

If, however, you wish to use the Connector Snap-in for configuring the
connector, these operating systems are not supported, because this snap-in
requires the Exchange System Manager.

NOTE: Do not confuse the Connector Snap-in with the User Extension
Snap-in. The Connector Snap-in is loaded from the Exchange System
Manager, whereas the User Extension Snap-in is loaded from the Active
Directory User and Computer (ADUC) MMC. See the installation and admin-
istration guide OpenScape Xpressions Microsoft Exchange Gateway for
details.

NOTE: Note the information in Section 6.1.2, “Supported Exchange
Versions”, on page 103 on using the Exchange 2003 Connector.

3.5 ExchAPL (Exchange 2003) Restrictions

1. Connection to the Exchange Front-End server is not supported.

2. The physical installation of the ExchAPL on an Exchange cluster system is
not permitted.

3. More than one ExchAPL connection to the same Exchange server is not
supported.

4. Itis impossible to install several ExchAPLs on one server.

5. Connections to virtual Exchange servers not having the Exchange MTA
service are not allowed.
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3.6 Restrictions on the Lotus Notes Integration

NOTE: The names of versions lower than IBM Notes 9 and IBM Domino 9 are
Lotus Notes and Lotus Domino.

1. Using Lotus Notes 6.5.2 to connect Lotus Domino is not released. Please use
Lotus Notes 6.5.1,6.5.3,6.5.4, 7, 8.0.x, 8.5.0 to 8.5.3 or IBM Notes 9.0 Social
Edition (Basic Configuration).

2. Operating the IBM/Lotus Notes Gateway in an xXSP Domino environment is
not possible.

3. Operating the IBM/Lotus Domino server and an XPR server on the same
computer has not been released.

4. Please verify that no automatic upgrade of the IBM/Lotus Notes Connector
clientis performed. This is the IBM/Lotus Notes client found between the XPR
and the IBM/Lotus Domino server. Before upgrading to a new IBM/Lotus
Notes version, you must consult the technician in charge. Other IBM/

Lotus Notes clients not found between the XPR and the IBM/Lotus Domino
server, for example user clients on workstations, may be upgraded.

5. optiClient 130 integration in IBM/Lotus Notes

IMPORTANT: For integrating optiClient 130 in IBM/Lotus Notes only the
scenarios 'Single user without roaming’ and 'Terminal server’ of the below
scenarios are released.

NOTE: Please obtain information about scenarios not released for the
optiClient 130 integration in Lotus Notes from the optiClient 130 release
notes.

IBM/Lotus Notes offers the following setup scenarios:
¢ Single user with roaming

Roaming is available from Lotus Notes 6.0.1.
¢ Single user without roaming

*  Multiple user with roaming

Roaming and the multiple-user installation are available from Lotus Notes
6.0.1.

e Multiple user without roaming

The multiple user installation is available from Lotus Notes 6.0.1.
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e Shared client

The shared-installation feature is a Lotus Notes 5.x element. A shared
client old installation can be used in connection with Lotus Notes 6 and
higher.

e Terminal server

IBM restricts the terminal server installation of IBM/Lotus Notes to a
single user without roaming.

6. The IBM/Lotus Notes preview does not show any fax messages and
voicemails in an individual ActiveXControl.

7. Ifyou connect XPR to IBM Notes 9.0 Social Edition (Basic Configuration) and
IBM Domino 9.0 Social Edition, use the mail templates for Lotus Notes 8.

3.7 Restrictions on using the "One Mailbox for Numerous Call Numbers"
Feature

It is usually not possible to use this feature with GSM devices because the
destination station number to be configured in the mobile phone for call
forwarding normally exceeds the maximum length permitted by the provider for
call forwarding.

3.8 Restrictions on connecting HiPath 8000 up to and including V3.0

NOTE: The OpenScape Voice PBX used to be called HiPath 8000 before
product version 3.1 R2.

An XPR server can only be connected to a HiPath 8000 up to and including
version 3.0 as terminal device with several channels (BGL, Business Group Line),
since the HiPath 8000 V3.0 does not support connecting from a voice mail when
connected via a trunk (EP, End Point). This results in restrictions, since the HiPath
8000 V3.0 does not provide some features for preregistered terminal devices.

e TLS (Transport Layer Security) is not supported.
* SRTP (Secure Real Transport Protocol) is not supported.
* Arbitrary originator phone numbers are not supported.

The absence of arbitrary originator phone numbers means that all calls made by
the XPR server appear at the HiPath 8000 with the caller number under which the
XPR server is registered with the HiPath 8000. XPR cannot set the phone number
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of an outgoing call to the phone number of the subscriber who has initiated the
call. This enables call charging only for the XPR server as a whole, but does not
allow an assignment to the calling subscriber.

Possible satellites may not have the same access phone numbers. Each satellite
requires an individual access phone number.

3.9 Restrictions on connecting to Hicom Office Pro/COM

Hicom Office Pro/Com does not permit direct call forwarding on no answer / ring
no answer from trunk calls to external lines. Instead, a destination call list with a
dummy subscriber (without a physical port) must be configured for the
OpenScape Xpressions user. User-specific call forwarding to OpenScape
Xpressions must be assigned to the dummy subscriber.

3.10 Restrictions on Co-residency with HiPath ProCenter V7.0 GP4

86

PBXs

If OpenScape Xpressions V7 and HiPath ProCenter V7.0 GP4 are installed on
the same computer, you can connect the following PBXs:

* HiPath 3000 V6.0 3800 SMR 8

* HiPath 3000 V5.0 3750 SMR 13

¢ HiPath 4000 V3.0 SMR 5 Patch 05

Sangoma Diva Server boards

The following Sangoma Diva Server boards are released:
e Sangoma Diva Server 4BRI-8M

e Sangoma Diva Server PRI/E1-30

Further restrictions

e Addistributed setup, where the XPR hardware is installed on one or several
satellite computers and the core is installed on a main computer, is not
supported.

¢ For the connection to all PBX types applies the restriction of a maximum of
1600 call attempts to the XPR per hour.

* XPR supports a maximum of 8 channels.

¢ IP connection to HiPath 3000/5000 respectively HiPath 4000 with Cornet-IP
is not supported.
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* The WebAssistant is not supported since the Internet Information server by
ProCenter is required.

A31003-S2370-S100-64-7620, 10/2025
OpenScape Xpressions V7 Release Notice, Service Documentation 87



Restrictions
Restrictions on a Cluster Installation

3.11 Restrictions on a Cluster Installation

1. On the two cluster nodes the following programs may be locally installed on
the nodes but not on the cluster. Please note that if licenses are required, one
license must be purchased for each node.

a) Client License Management (CLM)

b) Business Intelligence and Reporting Tool (BIRT)
c) Text-To-Speech (TTS)

d) Automatic Speech Recognition (ASR)

e) Application Builder

2. Only the following APLs may be installed on a Windows cluster without
project-specific release and have general availability:

a) XPR License Service

b) XPR Name Locator

c) XPR Configuration Service (cfgsvc)
d) XPR Status Dispatcher (xmrsvc)

e) XPR Information Store (infostor)

f) XPR Message Router (mta)

g) XPR Administrator (mrs)

h) XPR TCP/IP Transport Layer(TcpApl)
i) XPR stunnel

i) XPR Directory Service (dirsvc)

k) XPR Internet Mail APL (SMTPAPL)
I) XPR Web APL(WebApl)

m) XPR Mail APL(MailApl)

n) XPR Lear APL(Lear)

0) XPR Notification APL(NotApl)

p) XPR Lpr APL(LprApl)

gq) XPR CSTA APL (CSTAAPL)
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r) XPR Cti APL(CtiApl)

NOTE: General availability is only valid for a CSTA connection. For a
TAPI connection, only limited availability applies (see point 3a on page
89).

s) XPR ip APL(ipApl)

NOTE: This APL can be installed on a Windows cluster only without TTS
and ASR.

t) XPR Ldap APL(LdapApl)

u) XPR Presence APL(PresenceApl)
v) XPR XmIAPL(XmIApl)

w) XPR VM APL(VmApI)

x) XPR Printer APL(PrintApl)

3. The following APLs may be installed on a Windows cluster without project-
specific release, but they have limited availability only:

IMPORTANT: Limited availability means that this XPR service depends on
third-party software or contains this software and the producer of this third-
party software has not released it for Windows clusters. However, the corre-
sponding XPR component has been successfully tested as being operable on
a Windows cluster. If a modification or a bug in the third-party software makes
the XPR incompatible in a Windows cluster, Unify GmbH & Co KG will attempt
to provide a workaround. If such a workaround is not economically justifiable,
this problem may be finally solved by performing the XPR cluster installation
once more and in a way that this component is moved to a (not clustered)
satellite.

a) XPR Cti APL(CtiApl)

NOTE: Limited availability is only valid for a TAPI connection. For a
CSTA connection, only general availability applies (see point 2r on page
89).

A31003-S2370-S100-64-7620, 10/2025
OpenScape Xpressions V7 Release Notice, Service Documentation 89



Restrictions

Restrictions on a Cluster Installation

90

XPR Isdn APL(IsdnApl)

NOTE: This APL can be installed on a Windows cluster only without TTS
and ASR.

XPR SMS Large Account APL(SmsIPApI)
XPR Serial APL(V24Apl)
XPR Filelnterface APL(FiApl)

XPR Exchange Connector for i386(<XPR server name>:<Exchange
2003 server name>)

XPR Exchange Connector for i386(<XPR server name>:<Exchange
2007 server name>)

XPR Exchange UM APL

XPR Lotus Notes APL (LNAPL)

XPR Lotus Notes UM APL(LnUmApl)
XPR SAP R/3 APL (SapR3Apl)

IMPORTANT: Setting up this APL on a Windows cluster has been
released only project-specifically.

XPR SAPphone APL(SAPphoneApl)

IMPORTANT: Setting up this APL on a Windows cluster has been
released only project-specifically.

XPR Reporting APL(RepApl)

IMPORTANT: In case of setting up the Reporting APL on a cluster, the
XPR must be connected to a Microsoft SQL server that is on a computer
outside the cluster.

XPR Schedule APL(RepScheduleApl)

IMPORTANT: In case of setting up the Schedule APL on a cluster, the
XPR must be connected to a Microsoft SQL server that is on a computer
outside the cluster.
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0) XPR VM2TXT APL(Vm2TxtApl)

IMPORTANT: Please consider the restrictions outlined in point 38 on
page 75.

4. The following APLs are not admitted on a Windows cluster:
a) XPR Isdn APL(IsdnApl) with TTS and/or ASR
b) XPR ip APL(ipApl) with TTS and/or ASR
c) XPR Db APL(DbApl)
d) XPR SAP Business Routing APL (SAPROUTEAPL)
e) XPR HiPath Management APL(HpmApl)
f) XPR ABC APL(AbcApl)

g) The XPR Connection APL (UCC, Web Conference Server, PostgreSQL
and OpenScape Web Client) must neither be installed on the Windows
cluster nor locally on a cluster node.

NOTE: The XPR Connection APL may be installed with a project-specific
release on a satellite that is connected to an XPR kernel on a Windows
cluster. For further details see 6 on page 80. See also point 34 on page
74.

5. If you do not perform the application conversion with Ghostscript but with
Microsoft Office, you need to install Microsoft Office on both nodes. Please
remember that you need two licenses for this purpose.

6. You need to select an installation version during the setup process of
Windows Server 2008 SP2 Enterprise Edition. Only the installation version
Full Installation is supported. The installation version Server Core
Installation (no .NET framework, reduced GUI etc.) is not supported, even if
it is capable of clustering (see Section 2.6.2.1, “Server”, on page 57).
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4 Error Correction Procedures

Error reports from customers are entered in the SIS by the responsible CSC and
are handled in accordance with the regulated escalation procedures.
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5 Notes for Service Personnel

5.1 General Information

Besides the user guide and administrator documentation please also note the
XpressionsInstall\ReleaseNotes.rtf file onthe setup medium. Inthere
you are provided with current product notes that may not have been considered
for the documentation.

Before starting an installation, check in G-DMS (Global Document Management
System) if updated versions of the Release Notice and the Release Notes are
available.

The following tables reflect the product structure in the G-DMS / SWS (Software
Supply Server) and the diagnostics structure in the ICTS (International Case
Tracking System):

Main Category Applications

Product family OpenScape Xpressions
Product OpenScape Xpressions
Product version OpenScape Xpressions V7
Product Code P30152-P1526-A1-1

Table 19 Product Structure in the G-DMS / SWS
Product family Applications

Product group OpenScape Xpressions
Product type OpenScape Xpressions
Product version V7

SW version V7 1.0.0

Table 20 Diagnostics Structure in the ICTS
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5.2 Upgrading

You can upgrade to version OpenScape Xpressions 7 R1 only from versions
MRS 8.xx, OpenScape Xpressions 5.0 R4 FR13, 6 R0, 6 R1, 6 R2 and 7 RO.

Please obtain possible previous versions, intermediate versions that may be
required and restrictions on an upgrade from the following table. You find
information about upgrading to an intermediate version in the upgrade
instructions of the intermediate version.

Voice conferences are not supported for installations or upgrades of an XPR that
is connected to a HiPath 3000 V5, V6 and V7 and HiPath 4000 V3 and V4
because the program SIPControl is not supported anymore by Sangoma Diva.

From version Bit-width via the intermediate version(s) to version
XPR 7 RO 64 - XPR 7 R1
XPR 6 R2 64 - XPR 7 R1
32 123 XPR 7 R1
XPR 6 R1 32 4123 0r XPR6 R22° XPR 7 R1
XPR 6 RO 32 4123 or XPR 6 R22° XPR 7 R1
MRS 8.xx 64 -126or MRS 8.032° XPR 7 R1
32 -126 or MRS 8.032 ° XPR 7 R1
XPR 5.0 R4 32 XPR 5.0 R4 FR13" 27 or XPR 6 R2? XPR 7 R1
XPR 5.0 R3 32 XPR 5.0 R4 FR13" 27 or XPR 6 R2? XPR 7 R1
XPR 5.0 R2 32 XPR 5.0 R4 FR13" 27 or XPR 6 R2? XPR 7 R1
XPR 5.0 R1 32 XPR 5.0 R4 FR13" 27 or XPR 6 R2? XPR 7 R1
XPR 5.0 RO 32 XPR 5.0 R4 FR13" 27 or XPR 6 R2? XPR 7 R1

1

96

You upgrade the XPR 6 R2 32 bit, XPR 6 R1, XPR 6 R0, XPR 5.0 R4 FR13 or MRS 8.xx to XPR 7 DIRECTLY by executing the following
major steps:

- Make the TOV7 (to version 7) check box in the WebAssistant visible

- Back up the MRS/XPR data

- Uninstall the MRS/XPR

- Install the XPR 7 freshly

- Restore data

If the TOV7 check box is unavailable on your MRS/XPR server, check that the corresponding hotfixes have been installed instead. You can
obtain details of this topic from section 2.2 in the current Release Notes.

If you wish to perform a “normal” upgrade without data backup and restore, you do not need TOV7.

IMPORTANT: Be that you have one of the following source versions:

- XPR or MRS on a Windows cluster on a 32-bit operating system

- MRS 8.xx on a Windows cluster

Let us assume as well that you do not have a project-specific release for a Connection APL on a satellite computer.

If you want to upgrade to XPR 7 R1 on a Windows cluster (always on a 64-bit operating system), a project-specific release is needed for
XPR 7 R1 because for this upgrade certain parts of the Connection APL on a satellite computer are needed. See also point 34 on page 74,
point 7 on page 80 and point 4g on page 91.

The same applies if you want to upgrade XPR V5 R4 FR13 on a Windows cluster directly to XPR 7 R1.

The XPR WebClient data is not backed up prior to this upgrade. In other words, it must be manually configured after the upgrade in the
XPR 7 WebClient.

Upgrades from XPR 6 RO or 6 R1 to XPR 7 are only released for the case that no conferences have been released on your XPR.

This intermediate step is required only if conferences have been released on your MRS or XPR.
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6 This upgrade is possible only if MRS 8.03 is available or no conferences have been released on your MRS.
MRS 8.xx cyPhoneWeb data is not backed up prior to the upgrade. In other words, it must be manually configured after the upgrade in the
XPR -7 WebClient.

7 Please heed respectively comply with the following:
Make sure that the TOV7 check box is available in the WebAssistant.
The SMSIP APL exists on XPR 7 instead of the XPR 5.0 SMS APL. As a result, the SMS APL configuration gets lost during the upgrade.
The password of user Network Administrator and the local profile are retained during the upgrade only if the computer name (host name)
and the IP address of the XPR 5 server computer are used for the XPR 7 server computer also.
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5.3 Running Xpressions Setup with OpenSSL files on Hotfix folder

Some Xpressions services, in order to run, require you to have updated OpenSSL
files. When running Xpressions Setup those OpenSSL files are replaced with old
versions making some services not able to run again or some features not able
to be installed.

In order to prevent such problems, when running the Xpressions setup, the
OpenSSL files must be copied to the Xpressions setup HOTFIX folder.Those files
are now available on the latest OpenSSL hotfix.The OpenSSL hotfix contains a
folder named Files and its content must be copied to the HOTFIX folder on the
Xpressions setup installation path.
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5.3.1 Installing the SNMP feature

If you select the SNMP for license and SystemVersioninfo feature when
running the Xpressions setup with the OpenSSL file on the HOTFIX folder, you
may be prompted with a message informing you that the files are in use when the
setup tries to install the feature.

That is because the MS Windows SNMP Service is running.You will need to
manually stop this service and click 'try again' in order to make the setup
continue.

The SNMP service will be running after the setup finishes.
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5.4 Configuration Data Required for Start Up

100

Before switching the system on, the most important data for configuration should
be recorded so that the startup is not delayed by a numerous prompts.
Here is a list of the data required:

5.4.1 Necessary Data for Telecommunications (Call
Number Plan)

PABX trunk connection

External prefix

Tie trunk ID for OpenScape Xpressions

Call numbers provided for DID in OpenScape Xpressions (range information)

Type of the HiPath fax configuration (e.g. combi-fax numbers)

5.4.2 Necessary Data for the LAN

Computer name of the Windows computer

IP address

Domain into which the computer should be introduced
DHCP server

DNS server

WINS server
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5.5 Telephone User Interfaces

5.5.1 ERGO, PhoneMail and VMS

The telephone user interfaces (TUI) ERGO, PhoneMail and VMS are supported.
Such TUIs support the German, English, French, Dutch, Italian,
Spanish, Portuguese and Brazilian language.

5.5.2 Parallel Use of PhoneMail and VMS

The two telephone user interfaces PhoneMail and VMS can both be configured
on the same server in parallel and used specific to the subscriber. It is important
that the scripts and the subscribers are configured correctly. See the adminstrator
documentation OpenScape Xpressions Server Administration on this.

5.6 Exchange and IBM/Lotus Notes Integration without True Unified
Messaging

If an integration with Exchange or IBM/Lotus Notes is to be performed without
mailbox replication and True Unified Messaging, the following settings must be
made:

In registry the following key must be set to value 1:

HKLM\Software\PP-COM\MRS\MailAp\TumBackend

The following rule must be inserted before the first rule (replace 'server name’)
NVS:<server name>/*[TYPE=TRANS]=NVS:MAILBOX/*[ABORT=1].

The preferred rule must be changed as follows:

NVS:* */*[ABORT=0]=<PREFFERED>.
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5.7 Installation on Windows Server 2016

It has been experienced in some Openscape Xpressions installations on
Windows Server 2016 where Xpressions installation fail and it is not possible to
install 'nameloc' service.

UN'FY

OpenScape ¥preszions iz configuring your new software installation.

Mameloc iz being installed ...

The service cannot be installed.
Please read the last message in the event log.

Cancel
‘ oK
This seems to be a random issue after Windows Server 2016 is updated to latest
patch level and cannot be localized to a specific Microsoft Hotfix.

In order resolve this problem the installation must be canceled and it must be
verified the existance of the following Registry Key:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\LanmanServer
\Parameters\

NullSessionPipes [REG_MULTI_SZ]

In case it doesn't exist, you must create it manually.
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6 Information on Exchange Integration

6.1 Integration with Exchange

6.1.1 Supported Scenario

XPR supports the following scenario:

Only one Exchange organization
Only one administrative group and one routing group

The system manager with the latest SP is installed on the XPR server (SAT
too, if needed).

No Outlook is installed on the ExchAPL server.

Exchange Cluster is operated in a two-node configuration (active/passive).
ExchAPL is connected with the virtual Exchange server.

The LDAP APL is always installed on the XPR server.

Address book replication is activated for every domain that has XPR users.

NOTE: See Section 6.1.7.6, “Integration in Hosted Exchange 2007”, on page
109 and Section 6.1.8.2, “Integration in Hosted Exchange 2010”, on page 110 for
information about the integration in Hosted Exchange 2007 and 2010.

6.1.2 Supported Exchange Versions

Connection is possible to the following Exchange versions:

Microsoft Exchange Server 2003 SP2

Microsoft Exchange Server 2007

The following connection versions are possible:

— Direct connection to Exchange Server 2007 via the Exchange Connector
for Exchange Server 2007 (Foreign Connector).

NOTE: Integrated Messaging is not available with Exchange Server
2007. Already existing IM users must be reset to TUM users.
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— NOTE: This version is only supported for upgrading older XPR versions
to XPR V7.

The Microsoft Exchange Server 2007 is connected via the Exchange
2003 Connector. This Exchange 2003 Connector, an SDK connector, is a
Microsoft Exchange Server 2003 SP2. It is used as gateway to the
Exchange server 2007.

IMPORTANT: Please heed the restrictions on the operating systems
used for this connection version under point 6 on page 82.

¢ Microsoft Exchange Server 2010

The XPR Connector for Exchange Server 2010 is based on the Exchange
2007 Foreign Connector.

¢ Microsoft Exchange Server 2013 via a Microsoft Exchange Server 2007
gateway

* Microsoft Exchange Server 2013 via a Microsoft Exchange Server 2010
gateway only with a project-specifice releaseMicrosoft Exchange 2013

*  Microsoft Exchange 2016
¢ Microsoft Exchange Online (O0365)

6.1.3 Exchange Connector on a distributed System

If during reinstallation the Exchange Connector is installed on a satellite instead
of on the OpenScape Xpressions server, then this is a distributed system. In this
case follow the setup instructions for a distributed system in the OpenScape
Xpressions Server Installation instructions.

6.1.4 Multi-Connector Operation

Multi-connector operation (several Exchange servers at one XPR) is supported
for Exchange Server 2003, 2007, 2010 and 2013 (2013 only via a 2007/2010
gateway).

6.1.5 Exchange Connector

The Exchange Connector needs to be restarted for global activation of mailbox
replication. It must also be restarted in the case of all other Exchange Connector
global configuration changes.
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6.1.6 Connection to Exchange Server 2003 SP2

6.1.6.1 XPR Server with several Exchange Servers

Note: An XPR server can be connected to several Exchange servers only in
networks with the same Exchange Server software release (2003).
Consequently, the same hotfixes and the same service packs must have been
installed on the Exchange servers.
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6.1.7 Connection to Exchange Server 2007

6.1.7.1 Changes introduced with Exchange Server 2007

With Exchange Server 2007, Microsoft has introduced some essential
modifications and further developments compared to the previous version
Exchange Server 2003. The most important differences are:

¢ Upgrade of a 32-bit system to a 64-bit system. This means that Microsoft
allows life-operation of Exchange Server 2007 on a 64-bit system only.

¢ The combination of Exchange features to modules, the so-called Roles,
which enables a distributed setup of the Exchange Server 2007 on different
servers. This results in an improved scalability of the Exchange components.
The individual roles are called: Mailbox Server Role, Hub Transport Server
Role, UM Server Role, Client Access Server Role and Edge Transport Server
Role.

¢ Replacement of the SDK-connector concept with the foreign-connector
concept. This required an XPR connector redevelopment.

6.1.7.2 Administration Modifications

* Exchange management console

Exchange Server 2007 provides the new Exchange management console for
administering the Exchange Server 2007. Different from the Exchange
system manager, the sites and administrative groups known so far and also
the routing groups inclusive the routing group connectors have ceased to
exist in the Exchange management console, for example. The information for
thatis in case of Exchange Server 2007 administered via the Active Directory
(sites and services).

 Exchange management shell

The basic connector configurations are on the Exchange side performed via
the Exchange management shell.

6.1.7.3 The new XPR Connector

The new XPR connector is a so-called Exchange 2007 foreign connector. Its
executable file is the E2k72ap1 . exe. You find this file in the \bin directory of the
XPR server. The name of the connector in the XPR monitor still reads ExchApl.

The Foreign Connector is required for “store-and-forward” operation. It delivers
the messages received via the XPR server to the Exchange users and transmits
the Exchange server messages to be sent via the XPR server.

A31003-S2370-S100-64-7620, 10/2025
OpenScape Xpressions V7 Release Notice, Service Documentation



Information on Exchange Integration
Integration with Exchange

To this, a logical connection is established between the XPR server and the
Exchange modules “Mailbox Server Role” and “Hub Transport Server Role” via
the Foreign Connector.

The connection to the Exchange Mailbox Server Role is required for opening a
MAPI connection to resolve addresses.

The connection to the Exchange Hub Transport Server Role serves for
transporting messages from/to the XPR server.

NOTE: In case of a monolithic Exchange Server 2007 environment structure no
differentiation needs to be made between Mailbox Server Role and Hub
Transport Server Role. In this case the Foreign Connector is connected to the
computer that hosts the Exchange server 2007.

Messages are exclusively retrieved via direct access to the Exchange mailboxes
by means of the ExXUMApI. The new connector does not support inbox
replication. Integrated Messaging (IM) as XPR server operation mode is thus
not possible anymore.

The XPR TUM-Connector must establish a connection from the XPR server to the
Mailbox Server Role.

NOTE: In case of a monolithic Exchange Server 2007 environment structure no
differentiation needs to be made between Mailbox Server Role and Hub
Transport Server Role. In this case the XPR TUM-Connector is connected to the
computer that hosts the Exchange server 2007.

Message transport

The messages to be sent from the XPR server to users on the Exchange server
are stored in the <Replay Directory>. Messages to be sent by Exchange users
via the XPR server are stored in the Drop Directory>. In both cases such
messages are SMTP messages with the file extension .em1, and they are
buffered in the above directories until their final delivery.

The playback directories are found on the server that has the Mailbox Server
Role.

NOTE: In case of an Exchange Server 2007 environment with monolithic
structure the <Drop Directory> should be manually created in path
$Program Files%\Microsoft\Exchange Server.

The <Replay Directory> is created in path $Program
Files%$\Microsoft\Exchange Server\TransportRoles\Replay with
the installation of Exchange Server 2007.
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6.1.7.4 XPR Foreign Connector Administration Innovations

Owing to the changed Exchange Server 2007 administration, the administrative
access options differ from those you know from Exchange Server 2003.

* The XPR foreign connector is now exclusively configured via the ExchApl
settings dialog in the XPR monitor.

¢ Users are still administered via the MMC Snap-In extension for Active
Directory Users and Computers, which was already used for Exchange
Server 2003. To this, the MMC Snap-In must be installed on the system from
which the user configuration is performed.

6.1.7.5 XPR Features Modifications

In the Exchange connection context, the following XPR server features are
modified as a result from the new XPR foreign connector:

* Integrated Messaging (inbox replication) is not supported with the XPR
foreign connector anymore.

¢ The connector is exclusively configured via the ExchApl settings dialog in the
XPR monitor.
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6.1.7.6 Integration in Hosted Exchange 2007

IMPORTANT: We strongly recommend to discuss these requirements with your
provider during XPR installation planning, and to make sure the provider is able
and willing to support the requirements.

To integrate an XPR in Hosted Exchange 2007, the following requirements must
be complied with:

1. The XPRis installed at the customer's and not at the provider site. In other
words, it does not share the same location with Exchange.

2. An XPR satellite must be installed, on which the connectors operate at the
provider's within the Exchange domain.

NOTE: This does not require a physical server. A virtual server is sufficient.

3. This satellite must be connected to the XPR kernel computer in the customer
domain.

a) This requires a VPN connection or a similar network connection between
the satellite and the XPR kernel computer.

b) This connection must allow data traffic to the target ports 137, 138, 139,
445 and 13010 in both directions.

4. Services on the satellite and the XPR kernel computer must be able to access
the respectively other computer. In other words, the domains either trust each
other or working group authentication must be applied.

If you use working group authentication, execute the following sub-steps:

a) Create alocal user on the XPR kernel computer with the same user name
and password as for the domain user account used for the services of the
Exchange satellite.

b) Add this user account to the local administrator group.

c) Execute substeps a and b for the reverse direction, i.e. create a local user
on the satellite with the same user name and password as for the domain
user account of the services on the XPR kernel computer and add this
user account to the local administrator group.

d) Open Start > Settings > Control Panel > Administrative Tools > Local
Security Policy > Security Settings > Local Policies > Security
Options and verify that the Network access: Sharing and security
model for local accounts entry has value Classic - local users
authenticate as themselves.
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6.1.8 Connection to Exchange Server 2010

Connecting the XPR to an Exchange server 2010 or to Exchange Server 2010
CAS (Client Access Server) is supported. The following connections are
supported also:

¢ Exchange Server 2010 DAG (Data Availability Group)
* Exchange Server 2010 DAG and CAS

¢ Exchange Server 2010 CAS Array

» Exchange Server 2010 DAG and CAS Array

See the installation and administration manual OpenScape Xpressions Microsoft
Exchange Gateway for installation details.

NOTE: The process of setting up the Exchange Message Forms is identical for
Exchange Server 2007 and Exchange Server 2010.

6.1.8.1 Changes introduced with Exchange Server 2010

Exchange Server 2010 is based on version Exchange Server 2007, being an
improvement and extension of the latter.

Please note the following system property innovations to the previous version:

¢ Exchange Server 2010 is shipped exclusively as 64-bit version. The 32-bit
evaluation version is not longer available.

e Exchange Server 2010 runs exclusively on the operating system Windows
Server 2008 or Windows Server 2008 R2: Standard as well as Enterprise can
be used as version. However, the domain structure in which Exchange Server
2010 shall be integrated need not be based on Windows Server 2008.

* A new privilege assignment model in Microsoft Exchange Server 2010. This
privilege assignment model is called Role Based Access Control (RBAC). A
new method of assigning privileges to users of an organization in this model
is to combine such users in so-called Management Role Groups.

6.1.8.2 Integration in Hosted Exchange 2010

The statements in Section 6.1.7.6, “Integration in Hosted Exchange 2007”, on
page 109 are valid for Hosted Exchange 2010 also.
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6.1.9 Connecting to Exchange Server 2013 via an
Exchange 2007/2010 Domain

IMPORTANT: A project-specific release is needed for a connection via an
Exchange 2010 domain.

If an XPR server connection to an Exchange Server 2007/2010 environment has
already been configured, this connection can be used to access the mailboxes of
an Exchange Server 2013 to be newly integrated in this domain.

This requires the service account existing for the ExUM Apl in the Exchange
2007/2010 environment to be replaced with a new service account on Exchange
Server 2013. This new account must use the same logon data to allow access to
both the Exchange Server 2013 mailboxes and those of the older Exchange
environment.

The Exch Apl is still used as described in the manual. The service account need
not be adjusted for this Apl.

6.1.9.1 Overview

With Exchange Server 2013 appearing, some architectural changes have
become effective. For compatibility reasons, the components Collaboration Data
Objects (CDO) and Messaging API (MAPI) must therefore be updated to allow
supporting Exchange Server 2013.

To update these components, the configuration must be additionally adjusted for
the MAPI, so that the ExUM Apl can set up the connection to the Exchange
server.

You find detailed information about the installation (MAPI Download
configuration guidance.docx) under:

http://www.microsoft.com/en-us/download/details.aspx?1d=39045

6.1.9.2 General System Requirements

For Exchange Server 2013:
* Microsoft Exchange 2013 Server with Service Pack 1
Provision under:
http://www.microsoft.com/en-us/download/details.aspx?id=41994

For Xpressions V7 R1 FR3 or later
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* Exchange MAPICDO download version 08.03.0.8353

Provision under:

http://www.microsoft.com/en-us/download/details.aspx?1d=42040

e ExUmApl hotfix version 811-17591-i

NOTE: Please check that the previous ExchangeMAPICDO version is no longer
present on the system before you start setting up the new or a more recent
ExchangeMAPICDO 6.5.8353 version.
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6.1.10 Connection to Exchange Server 2013

Following the workaround that enables accessing an Exchange Server 2013 via
connecting an Exchange 2007/2010 domain you can now also directly connect
an Exchange Server 2013 domain by modifying the Exchange connectors.

6.1.10.1 Overview

With Exchange Server 2013 appearing, some architectural changes have
become effective. For compatibility reasons, the components Collaboration Data
Objects (CDO) and Messaging APl (MAPI) must therefore be updated to allow
supporting Exchange Server 2013.

Updating these components requires the configuration to be additionally adjusted
for the MAPI, so that the ExUM Apl can set up the connection to the Exchange
server.

You find detailed information about the installation (MAPT Download
configuration guidance.docx) under;

http://www.microsoft.com/en-us/download/details.aspx?id=39045

6.1.10.2 General System Requirements

For Exchange Server 2013:

* Microsoft Exchange 2013 Server with Service Pack 1

Provision under:

http://www.microsoft.com/en-us/download/details.aspx?id=41994

For Xpressions V7 R1 FR3 or later
* Exchange MAPICDO download version 08.03.0.8353

Provision under:

http://www.microsoft.com/en-us/download/details.aspx?id=42040
* The following hotfixes must have been installed on the Xpressions server:
— E2k7Apl V7 R1 FR4 or later
— ExUmApl V7 R1 FR4 or later
— LdapApl V7 R1 FR4 or later
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— MMCExchSnaplns V7 R1 FR4 or later

NOTE: Please check that the previous ExchangeMAPICDO version is no longer
present on the system before you start setting up the new or a more recent
ExchangeMAPICDO 6.5.8353 version.

A31003-S2370-S100-64-7620, 10/2025
114 OpenScape Xpressions V7 Release Notice, Service Documentation



Information on Exchange Integration
Integration with Exchange

6.1.11 Connection to Exchange Server 2016/
Exchange Online(0O365)

Xpressions now provides a solution for Exchange 2016 integration using the
Exchange Web Services interface.

6.1.11.1 Overview

As the MAPI support has been discontinued by Microsoft, a new XPR module

provides the integration by using the Exchange Web Services (EWSApI). This

module is responsible for the synchronization of the messages status between
the Exchange and Xpressions' mailboxes.

The SmtpApl also plays a role on the integration by sending the Voice and Fax
messages to the user's Exchange Mailbox.

For more details, please, consult:

OpenScape Xpressions V7, Microsoft Exchange Gateway, Administrator
Documentation
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7 Information for Users

7.1 IMAP4 Clients

» Directories may not be set up on the IMAP4 server. For this reason, the option
Move Message to Recycle Bin when Deleted in the Netscape Client must
not be activated since this means that the Trash folder is saved on the server.
Only local directories should be used to save messages in the inbox.

* The Send and Receive function in Outlook Express Client does not work
correctly. To update the inbox, you should briefly switch directories. The inbox
is then completely updated. The Connect button should not be used for
updating.

* Ifmessages in the IMAP4 client are deleted, they are only marked as deleted.
To finally remove the message, you need to execute the menu item Edit >
Permanently remove deleted messages in Outlook clients. Netscape, to
delete messages permanently, you must select the command File >
Compress this Folder.

7.2 Xpressions WebClient

* Internet Explorer 11 is supported by Xpressions WebClient only when running
in Compatibility View Mode. If you use Internet Explorer 11, make sure that
the compatibility view is used for the intranet, executing the following steps:
In the menu bar open Tools > Compatibility View settings... and check the
Display intranet sites in Compatibility View check box.

* The pearl icon in the upper left corner of the Xpressions WebClient is static.
It will not spin in order to alert the user that there are missed calls or new
voice-mail. To see notifications, hover the mouse over or click on the pearl
icon.
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